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Overview - SC 32 / SC 64
Based on the principles of the dbx Zone processing products, the SC 32 and SC
64 Digital Matrix Processors are the new flagship products for digital matrix
processing. Wizard driven configuration using HiQnet System Architect™ makes
unprecedented DSP power, incredible routing flexibility and a rich palette of
processing tools accessible with the minimum of training. The SC 32 and SC 64
represent the professional choice of foundation on which to build even the most
demanding integrated system.
The SC 32 / SC 64 has a total analog I/O count of 32 (the SC 64 has 64),
configurable in banks of eight. Eight analog input cards and eight analog output
cards facilitate five different fully loaded configurations (nine for the SC 64).
Analog input cards accommodate a wide range of sources with mic/line switching
and phantom power per input. Two high-speed options slots provide facility for
adding forthcoming high bandwidth audio transport I/O cards. All of these
features are housed in a sleek 2U rack chassis.
With dedicated DSP for common processing functions and insert positions for
specialized processing, the SC 32 / SC 64 offers many processing functions
including Advanced Feedback Suppression (AFS™), Ambient Noise
Compensation (ANC), priority ducking, parametric equalization (PEQ), delay and
dynamics. The SC 32 and SC 64 have a diverse range of control options
including HiQnet System Architect™ custom control panels, Ethernet, serial,
contact closure, the popular ZC wall controllers and even automatically
scheduled events. With so many methods of control, an SC system can truly be
tailored to suit the needs and technical expertise of even the most scrutinizing
contractor.
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Philosophy - SC 32 / SC 64
The memory structure of the SC 32 / SC 64 consists of Attributes and Presets.
Attributes
Device attributes are global functions that affect the entire device such as the
sample rate. Most of the SC 32 / SC 64 attributes are found in the Utilities section
of the Tools menu (see Utilities) in the Device Window. There are some attributes
that are managed directly from the Device Window, like Mutes and Solos (see
Device Window below).

Device Presets
A Device Preset is a snapshot of the current state of the SC 32 or SC 64. It
includes the parameter values of all of the Processing Modules in the current
configuration. Device Presets are managed from the Device Window using the
Preset bar (see Device Window). The Device Window shows the Processing
Modules prominently as icons, where each icon represents the Processing
Module in that signal path location. Double clicking on these icons allows the
user access to the underlying parameters of these modules. Saving a Device
Preset saves every parameter of all processing functions shown.

Files
Besides the Device Presets and Attributes that are stored on the SC device,
System Architect provides additional file types that can be saved to the
computer, the Device file and Venue file. The Device file captures the entire unit
including all Presets stored and all Attributes of that device. The Venue File is the
final extension; the Venue file is a snapshot of the entire Venue with the current
Preset and Attributes of every device in the venue. The Venue file is saved from
the File menu of the Venue View.

Device Window
All Presets, Processing Functions and their Parameters, as well as device
Attributes of the SC 32 / SC 64 are accessed via the Device Window. In addition
to these functions, the Device Window File Menu also provides the capability of
saving Device files.
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Front Panel
Controls/LEDs - SC 32 / SC 64
Front Panel LCD Display
Gives information relating to network configuration, current time and date, HiQnet
Node Address, SC firmware version and device status
Page / Select Buttons
Allow front panel navigation
RS-232 LED
Indicates a connection to the RS-232 port
Clip LED
Gives global DSP clip indication
Sync LED
Link / activity connection
Power LED
Power present indication

Card Position Label
I/O Card Type Indication
Analog or digital, input or output indication per card position
Clip LED
Analog clip indication per channel for inputs and outputs (19.9dB)
Sync LED
Digital Sync indication per card position for SC Digital Input / Output Cards
(coming soon)
Phantom Power LED
Phantom Power indication per channel for SC Analog Input Cards
Signal LED
Signal present indication per channel for inputs and outputs (-40dB)
Product Information
Product model and description
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Back Panel
Back Panel Connections - SC 32 / SC 64
Card Slots
Ethernet Connectivity
RS-232 Connectivity
ZC Inputs
Option Slots
Control Inputs
Relay Input
OPTO Connection
Logic Outputs
Power Input

Option Slots
High-speed Option Slots accommodating high-bandwidth networked audio option
cards (coming soon)
SC 32 - One Option Slot
SC 64 - Two Option Slots
Power Connector
IEC power connector
Fuse
Field-serviceable fuse
Control Inputs
Allow up to eight contact closures, faders or rotary potentiometers to used to
control HiQnet™ parameters
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Relay
Integrated relay with Normally Open (NO) and Normally Closed (NC) terminals
driven from HiQnet™ parameters
Opto
Opto-isolator conducts when device is powered and functioning correctly
Logic Outputs
Allow SC 32 / SC 64 to control up to six LED's or relays
Ethernet Connectors
Ethernet connectors for SC 32 / SC 64 configuration, control and monitoring as
well as integration of third party control systems using IP control (Integrated
Ethernet switch allows daisy-chaining of devices within a rack)
RS-232 Port
Serial port for integration with third party control systems
ZC Ports
Allow connection of up to 12 ZC controllers (six per port) for control of HiQnet
parameters

Card Position Label
Audio Connector
Balanced connections for installed I/O card
I/O Card Type Indication
Analog Input LED/Connector - Green
Analog Output LED/Connector - Orange
Digital* Input LED/Connector - Blue (coming soon)
Digital* Output LED/Connector - Yellow (coming soon)

*AES/EBU and S/PDIF
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Card Slots - SC 32 / SC 64
Card Slots - SC 32 / SC 64
Configurable in banks of 8, the SC 32 and 64 provide up to 32 and 64 channels
of audio respectively. Eight card slots facilitate five different fully loaded
configurations (nine in the SC 64). The Analog Input card accommodates a wide
range of sources with mic/line switching and phantom power per input.
I/O Card Type Indication
Analog Input LED/Connector - Green
Analog Output LED/Connector - Orange
Digital* Input LED/Connector - Blue (coming soon)
Digital Output LED/Connector - Yellow (coming soon)
*AES/EBU and S/PDIF
Card Types
Pin Out
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Card Types - SC 32 / SC 64
The SC 32/64 accepts Analog Input and Analog Output cards, carrying 8
channels per card.
I/O Card Type Indication
Analog Input LED/Connector - Green
Analog Output LED/Connector - Orange
Digital* Input LED/Connector - Blue (coming soon)
Digital* Output LED/Connector - Yellow (coming soon)
*AES/EBU and S/PDIF
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Pin out - SC 32 / SC 64

Overview:
The dbx SC 32 and SC 64 Analog Input and Analog Output Cards are designed
to populate any of the four or eight card slots on the dbx SC 32 and SC 64
devices respectively. These analog cards enable dbx SC devices to receive
microphone / line level signals and send line level signals.
The dbx SC 32 and SC 64 Analog Input Cards offer Phantom Power,
configurable per channel and software controlled analog gain in 6dB steps from
0dB to 48dB.
The Analog Cards each have two Combicon connectors which are used as
follows:
Analog Input Card :
•

•

Connector 1
o Balanced / Unbalanced Audio, Channel 1 - Mic/Line
o Balanced / Unbalanced Audio, Channel 2 - Mic/Line
Connector 2
o Balanced / Unbalanced Audio, Channel 3 - Mic/Line
o Balanced / Unbalanced Audio, Channel 4 - Mic/Line
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Analog Output Card:
•

•
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Connector 1
o Balanced / Unbalanced Audio, Channel 1 - Line
o Balanced / Unbalanced Audio, Channel 2 - Line
Connector 2
o Balanced / Unbalanced Audio, Channel 3 - Line
o Balanced / Unbalanced Audio, Channel 4 - Line

SC 32 / SC 64

Ethernet Connectivity - SC 32 / SC 64
Ethernet Connectors
Ethernet connectors for SC 32 / SC 64 configuration, control and monitoring as
well as integration of third party control systems using IP control (Integrated
Ethernet switch allows daisy-chaining of devices within a rack).
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RS-232 Connectivity - SC 32 / SC 64
RS-232 Port
Serial port for integration with third party control systems.

14

SC 32 / SC 64

ZC Inputs 1-6 and 7-12 - SC 32 / SC 64
ZC Ports
Allow connection of up to 12 ZC controllers (six per port) for control of HiQnet
parameters.
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Option Slots - SC 32 / SC 64
Option Slots
High-speed Option Slots accommodating high-bandwidth networked audio option
cards. (coming soon)
SC 32 - One Option Slot
SC 64 - Two Option Slots
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Control Inputs - SC 32 / SC 64
Control Inputs
Allows up to eight contact closures for control of HiQnet™ parameters.
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Relay Input - SC 32 / SC 64
Relay
Integrated relay with Normally Open (NO) and Normally Closed (NC) terminals
driven from HiQnet™ parameters.
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OPTO Connection - SC 32 / SC 64
Opto
Opto-isolator conducts when device is powered and functioning correctly.
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Logic Outputs - SC 32 / SC 64
Logic Outputs
Allow SC 32 / SC 64 to control up to six LEDs or relays.

20

SC 32 / SC 64

Power Input - SC 32 / SC 64
Power Connector
IEC power connector.
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Hardware
Spec Sheet - SC 32 / SC 64
FRONT PANEL INDICATORS
Per channel:
48V (yellow), CLIP (red), SIGNAL (green)
Per 8 channel bank:
IN (green), OUT (orange), D-IN (blue), D-OUT (yellow), SYNC (green)
Other:
16x2 LCD display, PAGE button (orange), SELECT button (green), CLIP (red),
LINK/ACT (green), RS-232 (green), POWER (green)

ANALOG INPUTS
Connectors:
Phoenix/Combicon, 3.5mm pitch
Channels:
Eight per card
Line/Mic Inputs:
Nominal gain 0 dB Electronically switchable to +6, +12, +18, +24, +30, +36, +42,
+48 dB
Type:
Electronically balanced, RF Filtered
Input Impedance:
3.5 k
Maximum Input Level:
+20 dBu
Noise Floor:
-92 dBu "A" weighted
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-90 dBu unweighted, 20 Hz - 20 kHz
Dynamic Range:
113 dB "A" weighted, 20 Hz - 20 kHz
110 dB unweighted, 20 Hz - 20 kHz
CMRR:
> 40 dB typical, >50 dB at 1 kHz
EIN:
< -119 dBu unweighted, 20 Hz - 20 kHz, 150 W source impedance
Phantom Power:
+48 VDC selectable per input
A/D Latency:
12/Fs

ANALOG OUTPUTS
Connectors:
Phoenix/Combicon, 3.5mm pitch
Channels:
Eight per card
Type:
Electronically balanced, RF Filtered
Impedance:
44
Maximum Output Level:
+20 dBu
Noise Floor:
-92 dBu "A" weighted
-89 dBu unweighted, 20 Hz - 20 kHz
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Dynamic Range:
112 dB "A" weighted
109 dB unweighted, 20 Hz - 20 kHz
D/A Latency:
10.4/Fs

SYSTEM PERFORMANCE
Dynamic Range:
110 dB "A"weighted
107 dB unweighted, 20 Hz to 20 kHz
Frequency Response:
20 Hz - 20 kHz, +0/-0.5 dB
THD+N:
0.0045% 0 dBu input, 1 kHz, 0 dB input gain
0.0065% 0 dBu input, 20 Hz - 20 kHz, 0 dB input gain
Inter-channel crosstalk:
> 90 dB typically, 20 Hz - 20 kHz
Internal Processing:
32 bit floating point
Internal Sample Rate:
48 kHz
Latency:
1.82 msec analog input to analog output
2.25 msec analog input to analog output with a mono mid-mixer

CONTROL INPUTS
24
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Connector:
Phoenix/Combicon, 3.5mm pitch
Number:
8
Control Voltage Input:
0 to 4.5 VDC
Control Line Impedance:
4.7 k to +5 VDC

ZONE CONTROLLER INPUTS
Connectors:
RJ-45
Number:
2 connectors with 6 channels per connector for a total of 12 inputs
Usage:
For use with dbx ZC wall controllers

LOGIC OUTPUTS
Connector:
Phoenix/Combicon, 3.5mm pitch
Number:
6
Logic Output Voltage:
0 or +5 V unloaded
Logic Output Impedance:
440
Logic Output Current:
10 mA source, 60 mA sink
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RELAY CONTACT CLOSURE
Connector:
Phoenix/Combicon, 3.5mm pitch
Contacts:
Common (C), Normally Open (NO), Normally Closed (NC)
Contact Rated Load:
0.3A at 125VAC, 1A at 30VDC

WATCHDOG OUTPUT
Connector:
Phoenix/Combicon, 3.5mm pitch
Type:
Opto-isolated
Output Current:
14 mA max
Withstanding Voltage:
80 V max (off)
Series Impedance:
220 isolated

MISCELLANEOUS
Power Requirements:
100 V to 240 VAC, 50/60 Hz
75 Watts for SC32, 120 Watts for SC64
26
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BTU Rating:
256 BTUs maximum for SC 32, 409 BTUs maximum for SC 64
Dimensions:
3.5" tall x 19" wide x 15" deep
Weight:
SC 32: 15.7 pounds (with all audio cards installed)
SC 64: 18.9 pounds (with all audio cards installed)

dbx incorporates high quality mechanical fans in some products. All mechanical
fans have a limited life expectancy. We recommend annual inspection of fans for
dust occlusion and excessive noise. Fan assemblies should be replaced after six
to ten years of use. Environmental factors such as elevated temperature, dust,
and smoke can adversely affect fan life. Systems exposed to these conditions
should be inspected more frequently. Fan replacement can be performed either
at the factory or by an experienced technician in the field. Please contact dbx
Technical Support for more information on purchasing replacement parts or
product service. dbx has a policy of continued product improvement and
accordingly reserves the right to change features and specifications without prior
notice.
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Device Window - SC 32 / SC 64
Device Window - SC 32 / SC 64
The Device Window (shown below) provides a graphical representation of the
processing occurring in the SC 32 / SC 64 unit. It also gives complete access to
a variety of tools that can be used to save or change the SC device.

Menus
The Menu Bar, along the top of the Device Window, offers a considerable
amount of control to the user. From this Menu Bar, Device files can be saved
and/or recalled. The Tools pull-down menu provides access to the Processing
Wizard that is used to change the device processing configuration as well as
Utilities where a majority of the SC attributes are shown and can be manipulated.
Presets
The Preset Tool located directly below the Menu Bar is used to Store and Recall
Presets to and from the SC device.
Processing Modules
Each Processing Module in the signal path of the SC 32 / SC 64 is displayed as
28
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an icon in the Device Window. These icons are designed to give a representation
of the processing that is occurring. Processing can be broken down into Input
and Output processing.
Input Processing
The input processing consists of a router, a delay, a 4-band parametric equalizer,
a gate and two insert positions.
Output Processing
The output processing consists of a router, an insert position, a band-pass filter,
a 6-band parametric equalizer, a limiter, a delay and a mute.
Meters
Four meters at the top of the Device Window represent input and output levels
throughout the signal path. The signal path represented by these meters is
determined by what input and output Processing Modules are selected at that
time.
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Right Click Device Window Menu - SC 32 / SC 64
When the user right clicks on the toolbar of the Device Window , the following
menu appears

Copy allows the user to copy all the settings within a particular Device Window
Paste allows the user to apply copied settings to different Device Windows
Copy HiQnet Information allows the user to copy device and string information
used for programming third party control systems.
Dock docks the Device Window into the System Architect's main window.
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Menus - SC 32 / SC 64
Menus - SC 32 / SC 64
At the top of the Device Window are the available menus.

File
Edit
View
Tools
Help
Selecting one of the above menus will open a menu of options within that menu.
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File Menu - SC 32 / SC 64
The File menu allows user access to store and recall program files.

Open allows you to open Device Files.
Save allows you to save Device Files.
Close will close the Device Window.
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Edit Menu - SC 32 / SC 64

The Edit menu allows copy and paste functions.
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View - SC 32 / SC 64
The View menu allows the user to dock windows including the Device Window.
While docked, the individual menus are selected using tabs across the top. Click
the view link on the menu bar.

Click on the dock selection. For example - A floating Device Window will look like
the image below. .

When the Device Window is docked, it will appear as seen in the following
image.
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This can be helpful when switching from editor to editor during programming.
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Tools Menu - SC 32 / SC 64
Tools - SC 32 / SC 64
The Tools Menu located on the Menu bar of the device view (or the main venue
view when the device is docked) contains most of the tools needed to configure
your device.

The Tools menu contains the following:
Hardware Configuration
Wizards
Utilities
Input Card Setup
Priority Mix Controls
I/O Card Meters
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Hardware Configuration - SC 32 / SC 64
Hardware Configuration - SC 32 / SC 64
The Hardware Configuration menu allows you to access Card Configuration and
Peripheral Configuration.

Card Configuration allows you to specify the input/output card configuration of an
offline SC 32 or SC64.
Peripheral Configuration allows you to choose the Zone Controllers, Control
Inputs, Logic Outputs and Relay use associated with the SC 32 and SC 64.
Card Configuration
Peripheral Configuration
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Card Configuration - SC 32 / SC 64
The SC 32 and SC 64 may come loaded in the following analog configurations:
SC 32: 8 x 0, 8 x 8, 8 x 16, 8 x 24, 16 x 0, 16 x 8, 16 x 16, 24 x 0, 24 x 8, 32 x 0,
0 x 8, 0 x 16, 0 x 24 and 0 x 32.
SC 64: 8 x 0, 8 x 8, 8 x 16, 8 x 24, 8 x 32, 8 x 40, 8 x 48, 8 x 56, 16 x 0, 16 x 8,
16 x 16, 16 x 24, 16 x 32, 16 x 40, 16 x 48, 24 x 0, 24 x 8, 24 x 16, 24 x 24, 24 x
32, 24 x 40, 32 x 0, 32 x 8, 32 x 16, 32 x 24, 32 x 32, 40 x 0, 40 x 8, 48 x 16, 56 x
0, 56 x 8, 0 x 8, 0 x 16, 0 x 24, 0 x 32, 0 x 40, 0 x 48, 0 x 56, 0 x 64.
Analog cards are available in two options, 8 analog input channels or 8 analog
output channels.
The SC 32 and SC 64 must be purchased in one of the previous configurations.
When the SC 32 and SC 64 are discovered by System Architect, the device and
it's currently loaded cards will automatically appear in the device and this step will
not be required.
When designing a system with an SC 32 or SC 64 in offline mode, you will need
to complete the following steps to properly configure your install. The device will
appear as 16 x 16 for the SC 32 and 32 x 32 for the SC 64 by default when
inserted into the Venue View.
Click on the Tools Menu as seen below.
Move your mouse over the Hardware Configuration option.
A fly out menu will appear.
Click on the Card Configuration option.
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The Card Configuration window will appear.
The Card Configuration window contains card slot dropdown menus where you
may choose the card that will be populated into the SC 32 and SC 64.
The SC 32 will have Card Slots "A" through "D" available and the SC 64 will have
Card Slots "A" through "H" available.

From each of the slot options seen here you will choose one of the following:
8 Ch. Analog In, 8 Ch. Analog Out or Empty.
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(NOTE: The factory will populate the cards with Inputs first starting in the Bottom
Right physical card slot "A" and then populate the rest of the slots "B", "C" and
"D" ending with output cards if used).
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Peripheral Configuration - SC 32 / SC 64
The SC 32 and SC 64 have a great number of peripheral device controls that
may be used. These options include Zone Controllers (ZC), Control Inputs, Logic
Outputs and a Relay connection.
When the SC 32 and SC 64 are discovered by System Architect, they WILL NOT
automatically detect peripheral device connections! The peripheral configuration
step will have to be completed with each device design containing direct
peripheral connections.
To access the Peripheral Configuration simply click on the Tools Menu as seen
below.
Move your mouse over the Hardware Configuration option.
A fly out menu will appear.
Click on Peripheral Configuration

The Peripheral Configuration window will appear.
This window contains individual window links on the left side of the page to Zone
Controllers 1-6, Zone Controllers 7-12, Control Inputs, Logic Outputs and Relay.

Peripheral Configuration Window
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The Peripheral Configuration window allows you to select the type of Zone
Controllers that will be attached to the SC 32 and SC 64.
The dropdown menu next to Type is where you choose the appropriate
controller. Your options are as follows.
ZC-1, ZC-2, ZC-3, ZC-4, ZC-Fire, ZC-6, ZC-7, ZC-8 and ZC-9.
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Once you have selected the ZC Controller to be used, you may then name the
control as seen below.

There is a great deal of information available on the Zone Controller page in
addition to the previously mentioned ZC Type and name.
Once the ZC controller type has been selected, a picture of the selected ZC
Controller will appear to the right. In addition, the port that the ZC Controller is
supposed to be plugged into on the back panel and the DIP switch settings are
displayed.
Zone Controllers with volume controls (ZC-1, ZC-2, ZC-6 and ZC-8) allow Gain
Boundaries to be specified. The Min Gain and Max Gain sliders specify the
minimum and maximum levels available from the ZC controller respectively.
Zone Controllers with a potentiometer (pot) (ZC-1 and ZC-2) allow a Pot Taper to
be specified. The options are Logarithmic, Linear and Custom. For a natural
volume response ‘feel’ on the ZC controller the following is recommended:
Wide ranges e.g. –Inf to +10dB – Specify Logarithmic
Narrow ranges e.g. -10dB to +10dB – Specify Linear
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Custom allows further control of the Pot Taper. Clicking on Edit brings up the
Custom Pot Taper Congfiguration window. This shows the fixed values of the
Logarithmic and Linear Tapers and editable values for the Custom Taper. These
editable values can be used to further enhance the perceived response of the ZC
volume pot.

Control Inputs

The Control Inputs section allows you to name physical controls that will be
connected to the SC 32 or SC 64.
The physical connection on the back of the SC device is highlighted in yellow to
the right as seen above.
There are a total of 8 Control Inputs available.
Contact closures may be connected to these ports.

44

SC 32 / SC 64
Logic Outputs

The Logic Outputs section allows you to name physical devices that will be
controlled or triggered by the SC 32 or SC 64.
The physical connection on the back of the SC device is highlighted in yellow to
the right as seen above.
There are a total of 6 Logic Outputs available.
Things such as relays and LEDs may be connected to these ports.
The Logic Outputs provide +5V when active and are at 0V when inactive.

Relay
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The Relay section allows you to name the Relay connection.
The Relay will provide either an open or closed state when active.
The physical connection on the back of the SC device is highlighted in yellow to
the right as seen above.
One relay is available.
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Wizards - SC 32 / SC 64
Wizards - SC 32 - SC 64
The Wizards menu is where you will go to set up all your processing for the SC
32 and SC 64.
There are three (3) wizards under the wizard option of the tools menu. The
Processing Wizard, Zone Controller Wizard and the GPIO Wizard. (General
Purpose Input/Output)
These wizards are used to specify physical hardware configuration and external
control options, configure processing and logical organization of channels and
assign external hardware to software parameters and vice versa.
To access the Wizards simply click on the Tools option on the menu bar from the
device view window.

Processing Wizard
Zone Controller Wizard
GPIO Wizard
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Processing Wizard - SC 32 / SC 64
Processing Wizard Overview - SC 32 / SC 64
The SC 32 and SC 64 are preconfigured architecture digital matrix processors.
The configuration of signal path and DSP processing modules are made easy
through the use of Wizards.
The Wizards are used to set up your SC 32 and SC 64. These Wizards provide a
step-by-step approach to the configuration of hardware and naming, routing,
organization and mixing of signals.
When designing a system, with an SC 32 or SC 64 in either online or offline
mode, you will need to complete the following steps to properly configure your
install.
To access the Processing Wizard, click on the Tools Menu as seen below.
Move your mouse over the Wizards option.
A fly out menu will appear.
Click on the Processing Wizard option.

The Welcome Screen for the Wizard will appear.
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Navigating the Processing Wizard
Navigating the Processing Wizard is made easy through the Quick Links to the
left side of the window or through the NEXT and BACK buttons located at the
bottom of the Wizard Screen.
You may click on Cancel at any time to exit the Wizard without saving any of the
changes.
When you have completed any or all sections of this Wizard and wish to
implement the changes made, simply press the FINISH button located at the
bottom right of the Processing Wizard window. This will load your design to either
an offline version of your device or load it straight into an online device.
A Help button is located at the bottom of the Processing Wizard screen that,
when pressed, will take you to the Processing Wizard Help File.
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Processing Wizard Overview - SC 32 / SC 64
The SC 32 and SC 64 are preconfigured architecture digital matrix processors.
The configuration of signal path and DSP processing modules are made easy
through the use of Wizards.
The Wizards are used to set up your SC 32 and SC 64. These Wizards provide a
step-by-step approach to the configuration of hardware and naming, routing,
organization and mixing of signals.
When designing a system, with an SC 32 or SC 64 in either online or offline
mode, you will need to complete the following steps to properly configure your
install.
To access the Processing Wizard, click on the Tools Menu as seen below.
Move your mouse over the Wizards option.
A fly out menu will appear.
Click on the Processing Wizard option.

The Welcome Screen for the Wizard will appear.
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Navigating the Processing Wizard
Navigating the Processing Wizard is made easy through the Quick Links to the
left side of the window or through the NEXT and BACK buttons located at the
bottom of the Wizard Screen.
You may click on Cancel at any time to exit the Wizard without saving any of the
changes.
When you have completed any or all sections of this Wizard and wish to
implement the changes made, simply press the FINISH button located at the
bottom right of the Processing Wizard window. This will load your design to either
an offline version of your device or load it straight into an online device.
A Help button is located at the bottom of the Processing Wizard screen that,
when pressed, will take you to the Processing Wizard Help File.
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Input Names and Routes - SC 32 / SC 64
To get to the Input Names and Routes section of the Processing Wizard, click on
the Input Names and Routes quick link or click on the Next button.
The Input Names and Routes window will appear.

The Input Names and Routes portion of the Processing Wizard allows you to
select sources from the available analog inputs and label the selected channel.
Click on the selection icon
channel.

next to a channel to choose a Route for that

The Route Selection window will open
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With the Input Route Selection window open, select one of the available input
channels as the source for the selected DSP channel.
(Note: Only channels associated with an input card will appear. Ex; there is one
analog input card loaded. Only A 1-8 will appear in this window)
With your input channel selected you may click on the Channel Label box to the
right and label your input channel.

Complete additional input channels in the same way as above.
When you have completed the Input Route Selection and channel labeling for all
desired channels, click on either the NEXT button or on the Input Groups link to
the left.
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Input Groups - SC 32 / SC 64
To get to the Input Groups section of the Processing Wizard, click on the Input
Groups quick link or click on the Next button until the Groups option is selected
under Inputs.
Input Groups allow you to organize DSP input channels into a logical order for
your install. You may create groups to contain things like the inputs within a
certain room or by type of input such as microphones.
We will start with the groups as they appear by default.

As you can see in the above image, the groups appear in logical order based on
the default 16 available inputs with card “A” and its channels in one group and
card “B” and it’s channels in the second group.

Renaming a Group
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To rename a group you will click once on that groups name. In the example
below I have clicked once on Group A. The group name will highlight and you
may start typing your replacement name for that group.
Repeat this process as needed. You may come back to the grouping section at
any time to change the group name, should a change be desired.

Creating a New Group
To create a new group click on the plus
window.

button at the bottom left of the group

Deleting a Group
To delete a group, select the group to be deleted and click on the minus button
at the bottom left of the group window.

Re-ordering Groups
To change the order of how groups appear in the list click on the group to be
moved.
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Then click on either the up or down arrow
down in the list.

to move the group up and

Moving DSP input channels to another Group
One you have named your inputs, the new name will appear as an input channel
within a group. The default in a 16x16 I/O configuration will appear with inputs 18 in “Group A” and inputs 9-16 in “Group B”. (NOTE: the numbering system is
based on the highest number of inputs (1-64) and the highest number outputs
(65-128) so numbers and controls never overlap) You may have as many of the
input channels in a group as you wish.
To move an input channel to another group, click and drag that channel from one
Group to the next. You may wish to reorder the input channels within a Group as
well. You may do this by dragging the input channel to another location within the
Group to create any channel order required for best use.

Default with 16x16 I/O configuration
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One Group Added.
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Channels one (Channel 1) and ten (Channel 10) moved to the new group.
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Input Inserts - SC 32 / SC 64
To get to the Input Inserts section of the Processing Wizard, click on the Input
Inserts quick link or click on the Next button until the Inserts option is selected
under Inputs.
Input Inserts allows you to choose which type of DSP processing will be inserted
for use on each input channel.

As you can see from the image above, the inserts are set up in the order of the
groups that you have created or selected. Clicking on a group name will allow
you to insert Processing Modules for the channels within that group.
Once you have selected a group, you may then use the dropdown menu for
Insert 1 and Insert 2 for a selected channel.
Clicking on the Insert 1 dropdown menu for channel one, as seen above, will
allow you to choose from one of the following Processing Module inserts.
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1) AFS (Advanced Feedback Suppression)
2) Auto Gain Control
3) Compressor
4) De-Esser
5) 12-Band Notch Filter
6) 12-Band Parametric EQ
7) Sub-Harmonic Synthesizer

Once you have selected a Processing Module insert for channel one (1), you
may click on the Fill Down button to use the same Processing Module insert for
any channels that follow within that group.
Input insert two (2) will follow the same steps as insert one (1). The list of
Processing Module inserts is the same as insert one (1) with the exception of
AFS.
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Mixers - SC 32 / SC 64
To get to the Mixers section of the Processing Wizard, click on the Mixers quick
link or click on the Next button until the Mixers option is selected.
Mixers are used to select multiple sources, set levels and create priority
overrides that will be routed to an output channel or multiple output channels.
The Mixer and Priority Mixing are covered in this topic.

The Mixers page above has no mixers loaded by default.

Adding a Mono Mixer
To add a Mono Mixer, click on the Add Mono Mixer Button.
A window will appear that allows you to name your new mixer.
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With your mixer added and named, you may click on the AFS check box to add
AFS post-processing if needed.

The Available Resources information will keep you updated with the number of
Mono Mixers and AFS inserts available for use.
The number of mixers available scales with the number of output cards in a
device - each output card adds 6 Mono Mixers. The number of AFS algorithms
scales with the number of input and output cards. Each input or output card adds
2 AFS algorithms.
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You may therefore have up to 12 Mono Mixers and 8 AFS algorithms in an SC 32
16x16 or 24 Mono Mixers and 16 AFS Inserts in an SC 64 32x32.

Removing a Mixer
To remove a Mixer, select the mixer to be removed by clicking on it in the list.
Click on the Remove button.

Reordering Mixers
If you have added two or more mixers you may change the order that the mixers
will appear. Select the mixer you wish to move from the list and click the up or
down arrow buttons
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Output Names and Routes - SC 32 / SC 64
To get to the Output Names and Routes section of the Processing Wizard, click
on the Output Names and Routes quick link or click on the Next button until the
Names and Routes option is selected under Outputs.

The Output Names and Routes section of the Processing Wizard allows you to
select sources from the available analog inputs, DSP Input Channels and Mixers
that you added. You may also change Crossover type and name each output
channel from this window.
Click on the selection icon
output channel.

next to a channel to choose a source for the

The Route Selection window will open.
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With the output Route Selection window open, select one of the available Analog
Inputs, DSP Inputs or Mixers to be routed to the output channel.
With your source channel selected you may click on the OK button to assign the
source or cancel to exit without making a change.
Complete additional Route selections in the same way as above.
Once you have selected a Route source you will name all of your output
channels.
Click on the channel number under the Channel Label heading and enter the
name you wish to call the output channel.

Now you will select the type of crossover, if any, that you want to use for the
outputs.
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You may choose one of the following crossover types.
1x1 (mono)
1x2 (mono bi-amp)
1x3 (mono tri-amp) or
1x4 (mono quad-amp)
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Output Groups - SC 32 / SC 64
To get to the Output Groups section of the Processing Wizard, click on the
Output Groups quick link or click on the Next button until the Groups option is
selected under Outputs.
Output Groups allow you to organize DSP output channels into a logical order for
your install. You may create groups to contain things like the rooms on a certain
floor of a building.
We will start with the groups as they appear by default.

As you can see in the above picture, the groups appear in logical order based on
the default 16 available outputs with card "C" and its channels in one group and
card "D" and its channels in the second group.
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Renaming a Group
To rename a group you will click once on that group's name. In the example
above I have clicked once on Group C. The group name will highlight and you
may start typing your replacement name for that group.
Repeat this process as needed. You may come back to the grouping section at
any time to change the group name, should a change be desired.

Creating a New Group
To create a new group click on the plus
window.

button at the bottom left of the group

Deleting a Group
To delete a group, select the group to be deleted and click on the minus button
at the bottom left of the group section.

Re-ordering Groups
To change the order of how groups appear in the list click on the group to be
moved.
Then click on either the up or down arrow
down in the list.

to move the group up and

Moving DSP output channels to another Group
Once you have named your outputs, the new name will appear as an output
channel within a group. The default in a 16x16 I/O configuration will appear with
Outputs 65-72 in "Group C" and Outputs 73-80 in "Group D". (NOTE: the
numbering system is based on the highest number of inputs (1-64) and the
highest number outputs (65-128) so numbers and controls never overlap). You
may have as many of the output channels in any one group as you wish.
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To move a DSP output channel to another group, click and drag that channel
from one group to the next. You may wish to reorder the DSP output channels
within a group as well. You may do this by dragging the DSP output channel to
another location within the group to create any channel order required for best
use.

Default with 16x16 I/O configuration.

One Group Added.
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Channel 65 and Channel 70 moved to the new group.
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Output Inserts - SC 32 / SC 64
To get to the Output Inserts section of the Processing Wizard, click on the Output
Inserts quick link or click on the Next button until the Inserts option is selected
under Outputs.
Output Inserts allows you to choose which type of DSP processing will be
inserted for use on each output channel.

As you can see from the image above, the inserts are set up in the order of the
groups that you have created or selected. Clicking on a group name will allow
you to insert Processing Modules for the channels within that group.
Once you have selected a group, you may then use the dropdown menu for the
Insert for a selected channel.
Clicking on the Insert dropdown menu for channel one, as seen above, will allow
you to choose from one of the following Processing Module inserts.
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1) Wire (default)
2) Amb. Noise Comp. (Ambient Noise Compensation)
3) Auto-Warmth
4) Auto Gain Control
5) Gain

You will choose Output Insert Processing Modules in groups as you did with the
Input Inserts.
Once you choose an Output Insert Processing Module, you may click on the Fill
Down button to populate remaining inserts with the insert that you have chosen
for the first channel within the group.
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ZC Wizard - SC 32 / SC 64
Zone Controller Wizard - SC 32 / SC 64
The SC 32 and SC 64 are semi-fixed architecture DSP matrix processors.
The configuration of Zone Controllers (ZCs) is made easy through the use of the
Zone Controller Wizard.
The Wizards represent an easy way to set up your SC 32 and SC 64. These
Wizards are designed to guide you step-by-step through the selection, options,
connection and DIP switch assignment for each Zone Controller. Simply fill in the
blanks provided in this step-by-step process and you have control.
When designing a system with an SC 32 or SC 64, in either online or offline
mode, you will need to complete the following steps to properly configure your
install.
To access the Zone Controller Wizard, click on the Tools Menu as seen below.
Move your mouse over the Wizards option.
A fly out menu will appear.
Click on the Zone Controller Wizard option.

The Welcome Screen for the Wizard will appear.
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Please see the following sections for programming ZC Controllers.
Navigating the ZC Controller Wizard
Zone Controller Options
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Navigating the ZC Wizard - SC 32 / SC 64
Navigating the Zone Controller Wizard is made easy through the Quick Links to
the left side of the window or through the NEXT and BACK buttons located at the
bottom of the Wizard Screen.

You may click on cancel at any time to exit out of the Wizard without saving any
of the changes.
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When you have completed any or all sections of this Wizard and wish to
implement the changes made simply press the FINISH button located at the
bottom right of the Zone Controller Wizard window. This will save your design to
either an offline version of your device or load it straight into an online device.
Click on the NEXT button or on the 1: <type of controller> link to the left. You will
have already inserted Zone Controllers in the Peripheral Configuration Wizard.
(See Peripheral Configuration)
In this example I have already assigned a ZC-1 to the 1: <No Controller> port in
the peripherals Configuration.

The 1: ZC-1 window will appear as seen below.

In the main right portion of the window you will see the following.
1) Type - This is the ZC Controller that is attached to the 1: ZC-1 port.
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2) Name - This is where the name of this ZC Controller, specified within the
Peripheral Wizard, is displayed. Ex: Room 1 Volume.
3) Action - The Action dropdown is where you will choose the action that the ZC
Controller will complete when adjusted. There are several actions that a ZC
Controller may take. These are driven by the type of Controller. The ZC-1 will
only allow Actions as listed below.
a. Gain - Adjust level
4) Below this section is a Gain Assignments section.
When you click on Add/Remove, the following window will appear.

5) This window allows you to select which DSP Channel Input or Output Gains to
control with the ZC-1 volume control. Multiple Gains can be assigned to a single
ZC Controller.
Please see the following sections.
Zone Controllers
ZC-1
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ZC-2
ZC-3
ZC-4
ZC-Fire
ZC-6
ZC-7
ZC-8
ZC-9
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SC ZC Options - SC 32 / SC 64
SC ZC Options - SC 32 / SC 64
The SC 32 and SC 64 may use a wide array of external controls. One of the
options is the ZC or Zone Controller.
The Zone Controllers offer extended utility to the SC 32 and SC 64. The nine
Zone Controllers use analog DC voltage to provide logic control ranging from
zone source selection, volume and muting, to Device Preset, Panel Preset and
Venue Recall selection and fire safety muting. Wired with readily available and
affordable CAT5 cable, with universally accepted RJ-45 connectors at distances
up to 1000 ft, the ZC Zone Controllers offer simple yet elegant solutions to the
contractor.
For wiring specifications see Wiring.
The Zone Controller options are as follows.

ZC-1
This remote device provides computer programmable rotary volume control for
the dbx DriveRack 260, 220i, 4800, ZonePRO™ and SC devices. The remote
device has DIP switches allowing identification with connection to the processing
device via CAT 5 cable on RJ-45 connectors. Seen here is the ZC-1 and ZC-1EU.
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ZC-1

ZC-2
This remote device provides computer programmable rotary volume and pushbutton mute control for the dbx DriveRack 260, 220i, 4800, ZonePRO™ and SC
devices. The remote device has DIP switches allowing identification with
connection to the processing device via CAT 5 cable on RJ-45 connectors. Seen
here is the ZC-2 and ZC-2-EU.

ZC-3
The remote device provides programmable rotary switch selection for the dbx
DriveRack 260, 220i, 4800, ZonePRO™ and SC devices. The remote device
provides rotary switch programmable source selection, page assignment, or
scene selection. The remote has DIP switches allowing identification with
connection to the processing device via CAT 5 cable on RJ-45 connectors. Seen
here is the ZC-3 and ZC-3-EU.
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ZC-4
The remote device provides programmable program selection via contact
closures for the dbx DriveRack 4800, ZonePRO™ and SC devices. The remote
device provides programmable source selection, page assignment, or scene
selection. The remote has DIP switches allowing identification with connection to
the processing device via CAT 5 cable on RJ-45 connectors. Seen here is the
ZC-4.
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ZC-FIRE
The remote device provides either output muting or programmable scene
selection. Connection to the fire safety system shall be either through a relay or
directly to the control voltage output. The remote device has DIP switches
allowing identification with connection to the processing device via CAT 5 cable
on RJ-45 connectors. Seen here is the ZC-Fire.

84

SC 32 / SC 64

ZC-6
The remote device provides computer programmable push-button up/down
volume control. The remote device has DIP switches allowing identification with
connection to the processing device via CAT 5 cable on RJ-45 connectors. Seen
here is the ZC-6 and ZC-6-EU.
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ZC-7
The remote device provides preset selection or programmable push-to-talk page
assignment. The remote device has DIP switches allowing identification with
connection to the processing device via CAT 5 cable on RJ-45 connectors. Seen
here is the ZC-7 and ZC-7-EU.
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ZC-8
The remote device provides both programmable push-button up/down volume
control, and programmable rotary switch source selection. The remote device
has DIP switches allowing identification with connection to the processing device
via CAT 5 cable on RJ-45 connectors. Seen here is the ZC-8 and ZC-8-EU.
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ZC-9
The remote device provides programmable 8 position source selection. The
remote device has DIP switches allowing identification with connection to the
processing device via CAT 5 cable on RJ-45 connectors. Seen here is the ZC-9
and ZC-9-EU.
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ZC-BOB
The remote device provides up to 6 RJ-45 input jacks for "Home Run" or parallel
wiring configurations. The remote device has one output RJ-45 jack for
connection to the dbx device. The ZC-BOB is designed to allow longer cable
lengths to multiple controllers. Seen here is the ZC-BOB.
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ZC1 - SC 32 / SC 64
The ZC-1 controller is the most commonly used controller and is used for volume
control of an input mic or line or output zone.
You can see below that a ZC-1 has already been configured in the Tools>Hardware Configuration->->Peripheral Configuration Wizard and is listed as 1:
ZC-1 below. If you don't see the Zone Controller you are looking for, in the list to
the left, please see Peripheral Configuration.
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Click on the NEXT button or on the 1: ZC-1 link to the left.
The 1: ZC-1 window will appear as seen below.

In the main right section of the window you will see the following.
6) Type - This is the ZC Controller that is attached to the 1: ZC-1 port.
7) Name - This is where the name of this ZC Controller, specified within the
Peripheral Wizard, is displayed. Ex: Room 1 Volume.
8) Action - The Action dropdown is where you will choose the action that the ZC
Controller will complete when adjusted. There are several actions that a ZC
92

SC 32 / SC 64
Controller may take. These are driven by the type of Controller. The ZC-1 will
only allow Actions as listed below.
a. Gain - Adjust level
9) Below this section is a Gain Assignments section.

When you click on Add/Remove, the following window will appear.

10) This window allows you to select which DSP Channel Input or Output Gains
to control with the ZC-1 volume control. Multiple Gains can be assigned to a
single ZC Controller.
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ZC2 - SC 32 / SC 64
The ZC-2 controller is a commonly used control for volume control and mute of
an input (mic or line) or output zone.
You can see below that a ZC-2 has already been configured in the Tools>Hardware Configuration->Peripheral Configuration Wizard and is listed as 2:
ZC-2 below. If you don't see the Zone Controller you are looking for, in the list to
the left, please see Peripheral Configuration.
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Click on the NEXT button or on the 2: ZC-2 link to the left.
The 2: ZC-2 window will appear as seen below.

In the main right section of the window you will see the following.
11) Type - This is the ZC Controller that is attached to the 2: ZC-2 port.
12) Name - This is where the name of this ZC Controller, specified within the
Peripheral Wizard, is displayed. Ex: Room 1 Volume.
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13) Action - The Action dropdown is where you will choose the action that the ZC
Controller will complete when adjusted. There are several actions that a ZC
Controller may take. These are driven by the type of Controller. The ZC-2 will
only allow Actions as listed below.
a. Gain - Adjust level
14) Below this section is a Gain Assignments section.
When you click on Add/Remove, the following window will appear.

15) This window allows you to select which DSP Channel Input or Output Gains
to control with the ZC-2 volume control. Multiple Gains can be assigned to a
single ZC Controller.
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ZC3 - SC 32 / SC 64
The ZC-3 controller is used to select sources, Device Presets, Panel
Presets,Venue Recalls and for page steering.
You can see below that a ZC-3 has already been configured in the Peripheral
Configuration Wizard and is listed as 3: ZC-3 below. If you don't see the Zone
Controller you are looking for, in the list to the left, please see Peripheral
Configuration.
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Click on the NEXT button or on the 3: ZC-3 link to the left.
The 3: ZC-3 window will appear as seen below.

In the main right section of the window you will see the following.
1) Type - This is the ZC- Controller that is attached to the 3: ZC-3 port.
2) Name - This is where the name of this ZC Controller, specified within the
Peripheral Wizard, is displayed. Ex: Room 1 Source.
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3) Action - The Action dropdown is where you will choose the action that the ZC
Controller will complete when adjusted. There are several actions that a ZC
Controller may take. These are driven by the type of Controller. The ZC-3 will
only allow Actions as listed below.
a. Input Select - Selects the input to be routed to an Input or Output
b. Actions Select - Selects any Actions to be performed. This may be in the
form of Device Presets, Panel Presets or Venue Recalls assigned to the
four positions.
4) Router Type - This control allows you to choose the Input Router section or
the Output Router section as the target for the Destination.
5) Destination Selection - Based on the Router Type selected, this control allows
you to further narrow down which DSP Input(s) or DSP Output(s) are controlled
via the ZC.
6) Source Assignment - This section determines what will be routed to the
selected destination(s).

Action: Input Select
When Input Select is listed in the Action dropdown list, the following screen will
display.
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You will now choose a destination (or multiple destinations) where a Source will
be routed.
Clicking on the Add/Remove button will bring up the following screen.
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Select the Destinations from the list to which the Source will be routed.
Click on OK to save changes.
From the Source Assign section you will now click on the Source Assign button
as seen below.

The Route Selection window will open.

If DSP Input is selected for Router Type you will get the following options:
•

Analog Input

If DSP Output is selected for Router Type you will get the following options:
•

Analog Inputs
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•
•

DSP Inputs
Mixers

Action: Actions Select
When Actions Select is listed in the Action Dropdown Menu, the following screen
will display.
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You will now choose an action to be taken when in the ZC-3 is switched through
between "a" and "d".

Click on the button to the right of each letter to open the Action Select Editor.

The Action Select Editor opens as seen below.
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The Action Select Editor allows you to name your Action List, provide a
Description and Add and Remove Actions.
The Add and Remove buttons allow you to Add actions and Remove them as
needed.
The Move Up and Move Down Buttons allow you to reorder the Actions within the
list.
Click on the Add Button to create a new action for the ZC-3 in position "A".
The Select Action Type window will appear.
The dropdown list will allow you to recall one of the following 3 actions.

1) Device Preset
2) Panel Preset
3) Venue Recall
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In this case I am going to choose a Panel Preset. Please see Panel Preset to
create Panel Presets.
The Select Panel Preset window opens.

You may now select the Panel and the Panel Preset that will be recalled when
the ZC-3 is changed between positions "A" and "D".
Once you click on OK, the changes will appear in the Actions Select window.
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Click on OK and your Action is set.

Complete the preceding steps for actions in the "B", "C" and "D" positions.
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ZC4 - SC 32 / SC 64
The ZC-4 controller is used to select sources, Device Presets, Panel
Presets,Venue Recalls and for page steering.
You can see below that a ZC-4 has already been configured in the Peripheral
Configuration Wizard and is listed as 4: ZC-4 below. If you don't see the Zone
Controller you are looking for, in the list to the left, please see Peripheral
Configuration.
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Click on the NEXT button or on the 4: ZC-4 link to the left.
The 4: ZC-4 window will appear as seen below.

In the main right portion of the window you will see the following.
In the main right section of the window you will see the following.
7) Type - This is the ZC Controller that is attached to the 4: ZC-4 port.
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8) Name - This is where the name of this ZC Controller, specified within the
Peripheral Wizard, is displayed. Ex: Room 1 Source.
9) Action - The action dropdown is where you will choose the action that the ZC
Controller will complete when adjusted. There are several actions that a ZC
Controller may take. These are driven by the type of Controller. The ZC-4 will
only allow Actions as listed below.
a. Input Select - Selects the input to be routed to an Input or Output
b. Actions Select - Selects any actions to be performed. This may be in the
form of Device Presets, Panel Presets or Venue Recalls assigned to the 16
positions.
10) Router Type - This control allows you to choose the Input Router section or
the Output Router section as the target for the Destination.
11) Destination Selection - This control allows you to choose where you are
routing the assigned Source. Multiple destinations can be selected.
12) Source Assignment - This section determines what will be routed to the
selected destination(s).

Action: Input Select
When Input Select is listed in the Action dropdown list, the following screen will
display.

109

SC32/SC64 Help

You will now choose a destination (or multiple destinations) where a Source will
be routed.
Clicking on the Add/Remove button will bring up the following screen.
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Select the Destinations from the list to which the Source will be routed.

Click on OK to save changes.

From the Source Assign section you will now click on the Source Assign button
as seen below.

The Route Selection window will open.

If DSP Input is selected for Router Type you will get the following options:
•

Analog Input
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If DSP Output is selected for Router Type you will get the following options:
•
•
•

Analog Inputs
DSP Inputs
Mixers

Action: Actions Select
When Actions Select is listed in the Action Dropdown Menu, the following screen
will display.
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You will now choose an Action to be taken when the ZC-4 is switched through
between "a" and "p" via binary contact closure.
Click on the button to the right of each letter to open the Actions Select Editor.

The Actions Select Editor opens as seen below.
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The Actions Select Editor allows you to name your Action List, provide a
Description and Add and Remove Actions.
The Add and Remove buttons allow you to Add actions and Remove them as
needed.
The Move Up and Move Down Buttons allow you to reorder the Actions within the
list.
Click on the Add Button to create a new action for this ZC-4 in position "a".
The Select Action Type window will appear.
The dropdown list will allow you to recall one of the following 3 actions.
4) Device Preset
5) Panel Preset
6) Venue Recall
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In this case I am going to choose a Panel Preset. Please see Panel Preset to
create Panel Presets.
The Select Panel Preset window opens.

You may now select the Panel and the Panel Preset that will be recalled when
the ZC-4 is changed between positions "a" through "p".

The changes once you click on OK will appear in the Actions Select window.
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Click on OK and your action is set.
Complete the preceding steps for actions in the remaining positions.
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ZCFIRE - SC 32 / SC 64
The ZC-FIRE controller is used for either output muting or programmable preset
selection. Connection to the fire safety system shall be either through a relay or
directly to the control voltage output .
You can see below that a ZC-FIRE has already been configured in the Peripheral
Configuration Wizard and is listed as 5: ZC-FIRE below. If you don’t see the
Zone Controller you are looking for, in the list to the left, please see Peripheral
Configuration.
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Click on the NEXT button or on the 5: ZC-FIRE link to the left.

The 5: ZC-FIRE window will appear as seen below.

In the main right portion of the window you will see the following.
13) Type – This is where the name of this ZC Controller, specified within the
Peripheral Wizard, is displayed. Ex: Fire.
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14) Action – The Action dropdown is where you will choose the Action that the
ZC Controller will complete when adjusted. There are several actions that a ZC
Controller may take. These are driven by the type of Controller. The ZC-FIRE will
only allow Actions as listed below.
a. Fire Control
15) Fire Control Configuration – This allows you to choose whether the fire
system will be considered on and active when the ZC-FIRE state port is high or
low.
16) Alarm State Action – This section allows you to decide what the ZC-device
will do when the fire system is active. The system will take one of two actions.
a. Mute all outputs when active
b. Load a specific preset when active. When this action is set you must also
choose the preset that will be loaded when the fire state has ended.
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ZC6 - SC 32 / SC 64
The ZC-6 controller is commonly used for volume control of an input (mic or line)
or output zone.
You can see below that a ZC-6 has already been configured in the Peripheral
Configuration Wizard and is listed as 6: ZC-6 below. If you don't see the Zone
Controller you are looking for, in the list to the left, please see Peripheral
Configuration.

120

SC 32 / SC 64
Click on the NEXT button or on the 6: ZC-6 link to the left.
The 6: ZC-6 window will appear as seen below.

In the main right section of the window you will see the following.
17) Type - This is the ZC Controller that is attached to the 6: ZC-6 port.
18) Name - This is where the name of this ZC Controller, specified within the
Peripheral Wizard, is displayed. Ex: Room 1 Volume.
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19) Action - The Action dropdown is where you will choose the Action that the ZC
Controller will complete when adjusted. There are several actions that a ZC
Controller may take. These are driven by the type of Controller. The ZC-6 will
only allow Actions as listed below.
a. Gain - Adjust level
Below this section is a Gain Assignments section.
When you click on Add/Remove, the following window will appear.

This window allows you to select which DSP Channel Input or Output Gains to
control with the ZC-6 volume control. Multiple Gains can be assigned to a single
ZC Controller.
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ZC7 - SC 32 / SC 64
The ZC-7 controller is used for preset recall or page steering control of an input
mic or line to an output zone.
You can see below that a ZC-7 has already been configured in the Peripheral
Configuration Wizard and is listed as 7: ZC-7 below. If you don’t see the Zone
Controller you are looking for in the list to the left please see Peripheral
Configuration.
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Click on the NEXT button or on the 7: ZC-7 link to the left.
The 7: ZC-7 window will appear as seen below.

In the main right section of the window you will see the following.
1) Type – This is the ZC Controller that is attached to the 7: ZC-7 port.
2) Name – This is where the name of this ZC Controller, specified within the
Peripheral Wizard, is displayed. Ex: Main Page.
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3) Action – The Action dropdown is where you will choose the Action that the ZC
Controller will complete when adjusted. There are several actions that a ZC
Controller may take. These are driven by the type of Controller. The ZC-7 will
only allow Actions as listed below.
a. Actions Select – Selects any actions to be performed. This may be in the
form of Device Presets, Panel Presets or Venue Recalls assigned to the
four buttons.

When you choose to add an action with the icon to the right of the a-d buttons,
the following will appear.

This window allows you to select an action to be taken by the control when
pressed.
Click on Add to select an action.

The following window will appear.
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This window allows you to choose a Device Preset, Panel Preset or Venue
Recall to occur when selected.
Multiple Actions can be assigned to a single button press or release.

See the following sections for more information
Creating a Panel Preset
Creating a Device Preset
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ZC8 - SC 32 / SC 64
The ZC-8 controller is used to select sources, Device Presets, Panel Presets,
and Venue Recalls via a four position rotary control and input, mixer or output
zone volume via up/down volume buttons.
You can see below that a ZC-8 has already been configured in the Hardware
Peripherals Configuration Wizard and is listed as 8: ZC-8 below. If you don't see
the Zone Controller you are looking for, in the list to the left, please see
Peripheral Configuration.
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Click on the NEXT button or on the 8: ZC-8 link to the left.
The 8: ZC-8 window will appear as seen below.

In the main right section of the window you will see the following.
4) Type - This is the ZC Controller that is attached to the 8: ZC-8 port.
5) Name - This is where the name of this ZC Controller, specified within the
Peripheral Wizard, is displayed. Ex: Room 1 Source.
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6) Action - The Action dropdown is where you will choose the action that the ZC
Controller will complete when adjusted. There are several actions that a ZC
Controller may take. These are driven by the type of Controller. The ZC-8 will
only allow Actions as listed below.
a. Input Select - Selects the input to be routed to an Input or Output
b. Actions Select - Selects any actions to be performed. This may be in the
form of Device Presets, Panel Presets or Venue Recalls assigned to the
four positions.
7) Below this section is a Gain Assignments section.

When you click on Add/Remove, the following window will appear.

This window allows you to select which DSP Channel Input or Output Gains to
control with the ZC-8 volume control. Multiple Gains can be assigned to a single
ZC Controller.
8) Router Type - This control allows you to choose the Input Router section or
the Output Router section as the target for the Destination.
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9) Destination Selection - This control allows you to choose where you are
routing the assigned Source. Multiple destinations can be selected.
10) Source Assignment - This section determines what will be routed to the
selected destination(s).

Action: Input Select
When Input Select is listed in the Action dropdown list, the following screen will
display.
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You will now choose a destination (or multiple destinations) where a Source will
be routed.
Clicking on the Add/Remove button will bring up the following screen.

Select the Destinations from the list to which the Source will be routed.

Click on OK to save changes.

From the Source Assign section you will now click on the Source Assign button
as seen below.

The Route Selection window will open.
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If DSP Input is selected for Router Type you will get the following options:
•

DSP Inputs

If DSP Output is selected for Router Type you will get the following options:
•
•
•

Analog Inputs
DSP Inputs
Mixers

Action: Actions Select
When Actions Select is listed in the Action Dropdown Menu, the following screen
will display.
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You will now choose an action to be taken when in the ZC-8 is switched through
between "a" and "d".
Click on the button to the right of each letter to open the Action Select Editor.

The Action Select Editor opens as seen below.
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The Actions Select Editor allows you to name your Action List, provide a
Description and Add and Remove Actions.
The Add and Remove buttons allow you to Add actions and Remove them as
needed.
The Move Up and Move Down Buttons allow you to reorder the Actions within the
list.
Click on the Add Button to create a new action for this ZC-8 in position "A".
The Select Action Type window will appear.
The dropdown list will allow you to recall one of the following 3 actions.
1) Device Preset
2) Panel Preset
3) Venue Recall
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In this case I am going to choose a Panel Preset. Please see Panel Preset to
create Panel Presets.
The Select Panel Preset window opens.

You may now select the Panel and the Panel Preset that will be recalled when
the ZC-8 is changed between positions "A" through "D".
Once you click on OK, the changes will appear in the Actions Select window.
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Click on OK and your Action is set.
Complete the preceding steps for actions in the "B", "C" and "D" positions.
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ZC9 - SC 32 / SC 64
The ZC-9 controller is used to select sources/presets and may be used for page
steering.
You can see below that a ZC-9 has already been configured in the Hardware
Peripherals Configuration wizard and is listed as 9: ZC-9 below. If you don't see
the Zone Controller you are looking for, in the list to the left, please see
Peripheral Configuration.
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Click on the NEXT button or on the 9: ZC-9 link to the left.
The 9: ZC-9 window will appear as seen below.

In the main right section of the window you will see the following.
11) Type - This is the ZC Controller that is attached to the 9: ZC-9 port.
12) Name - This is where the name of this ZC Controller, specified within the
Peripheral Wizard, is displayed. Ex: Room 1 Source.
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13) Action - The Action dropdown is where you will choose the Action that the ZC
Controller will complete when adjusted. There are several actions that a ZC
Controller may take. These are driven by the type of Controller. The ZC-9 will
only allow Actions as listed below.
a. Input Select - Selects the input to be routed to an Input or Output
b. Actions Select - Selects any actions to be performed. This may be in the
form of Device Presets, Panel Presets or Venue Recalls assigned to the
eight positions.
14) Router Type - This control allows you to choose the Input Router section or
the Output Router section as the target for the Destination.
15) Destination Selection - This control allows you to choose where you are
routing the assigned Source. Multiple destinations can be selected.
16) Source Assignment - This section determines what will be routed to the
selected destination(s).

Action: Input Select
When Input Select is listed in the Action dropdown list, the following screen will
display. ZC9 in ZC wizard
You will now choose a destination (or multiple destinations) where a Source will
be routed.
Clicking on the Add/Remove button will bring up the following screen.
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Select the Destinations from the list to which the Source will be routed.
Click on OK to save changes.
From the Source Assign section you will now click on the Source Assign Button
as seen below.

The Route Selection window will open.
If DSP Input is selected for Router Type you will get the following options:
•

DSP Inputs

If DSP Output is selected for Router Type you will get the following options:
•
•
•
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Action: Actions Select
When Actions Select is listed in the Action Dropdown Menu, the following screen
will display.
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You will now choose an Action to be taken when in the ZC-9 is switched through
between "a" and "h".

Click on the button to the right of each letter to open the Actions Select Editor.
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The Actions Select Editor opens as seen below.

The Actions Select Editor allows you to name your Action List, provide a
Description and Add and Remove Actions.
The Add and Remove Buttons allow you to Add Actions and Remove them as
needed.
The Move Up and Move Down Buttons allow you to reorder the Actions within the
list.
Click on the Add Button to create a new action for this ZC-9 in position "A".
The Select Action Type window will appear.
The dropdown list will allow you to recall one of the following 3 actions.
4) Device Preset
5) Panel Preset
6) Venue Recall
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In this case I am going to choose a Panel Preset. Please see Panel Preset to
create Panel Presets.
The Select Panel Preset window opens.

You may now select the Panel and the Panel Preset that will be recalled when
the ZC-9 is changed between positions "A" through "H".

Once you click on OK, the changes will appear in the Actions Select window.
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Click on OK and your action is set.
Complete the preceding steps for actions in the remaining positions.
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ZC-BOB - SC 32 / SC 64
The ZC-BOB provides up to 6 RJ-45 input jacks for "Home Run" or parallel wiring
configurations. This remote device has one output RJ-45 jack for connection to
the dbx device. The ZC-BOB is designed to allow longer cable lengths to multiple
controllers.
The ZC-BOB is non-programmable and non-powered.
A single connection from a ZC to a dbx device allows up to a 1000 foot cable run
to that ZC. ZC controllers may be linked from one to the next (or daisy chained in
a single run) but this comes at a price. As you daisy chain the controllers the
overall length of the run must decrease.
The ZC-BOB resolves this issue. With the ZC-BOB attached to a dbx device with
25 feet or less of cable between the ZC-BOB and that device, you may get up to
1000 foot "Home Runs" to each of the 6 ZC controllers attached.
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GPIO Wizard - SC 32 / SC 64
The SC 32 and SC 64 are preconfigured architecture DSP digital matrix
processors.
The configuration of General Purpose Input/Output (GPIO), namely Control
Inputs, Logic Outputs and The Relay are made easy through the use of the GPIO
Wizard.
The Wizards represent an easy way to set up your SC 32 and SC 64. These
Wizards are designed to guide you step-by-step through the selection and
options for each GPIO. Simply fill in the blanks provided in this step-by-step
process and you have control.
When designing a system with an SC 32 or SC 64 in either online or offline
mode, you will need to complete the following steps to properly configure your
install.
To access the GPIO Wizard, click on the Tools Menu as seen below.
Move your mouse over the Wizards option.
A fly out menu will appear.
Click on the GPIO Wizard option.

The Welcome Screen for the Wizard will appear.
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Navigating the GPIO Wizard
Navigating the GPIO Wizard is made easy through the Quick Links to the left
side of the window or through the NEXT and BACK buttons located at the bottom
of the Wizard Screen.
Names of Control Inputs, Logic Outputs and the Relay configured in the
Peripheral Configuration Wizard will be shown on the left side of the window.
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You may click on cancel at any time to exit out of the Wizard without saving any
of the changes.
When you have completed any or all sections of this Wizard and wish to
implement the changes made simply press the FINISH button located at the
bottom right of the GPIO Wizard window. This will save your design to either an
off-line version of your device or load it straight into an on-line device.
Click on the NEXT button or on the first Control Input link to the left. You may
have already inserted Control Input names in the Peripheral Configuration
Wizard.
(See Peripheral Configuration)
The Control Input 1 window will appear as seen below.
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In the main right section of the window you will see the following.
Name - This is where the name of this Control Input, specified within the
Peripheral Wizard, is displayed.
Action - The Action dropdown is where you will choose the Action that the
Control Input will complete when adjusted. There are several actions that a
Control Input may take. The Control Input will only allow Actions as listed below.
Actions Select - Selects any actions to be performed. This may be in the form of
Device Presets, Panel Presets or Venue Recalls assigned to the Control Input.
Subscription - Selects 'on/off' parameters to be controlled by the Control Input.
Click on the NEXT button or on each subsequent Control Input link to the left to
configure the remaining Control Inputs.
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Click on the NEXT button or on the first Logic Output link to the left. You may
have already inserted Logic Output names in the Peripheral Configuration
Wizard.
(See Peripheral Configuration)
The Control Output 1 window will appear as seen below.

In the main right section of the window you will see the following.
Name - This is where the name of this Logic Output, specified within the
Peripheral Wizard, is displayed.
Action - The Action dropdown is where you will choose the what controls the
Logic Output. The Logic Output will only allow Actions as listed below.
Subscription - Selects 'on/off' parameters to control the Logic Output.
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Click on the NEXT button or on each subsequent Logic Output link to the left to
configure the remaining Logic Outputs.
Click on the NEXT button or on the Relay link to the left. You may have already
inserted a Relay name in the Peripheral Configuration Wizard.
(See Peripheral Configuration)
The Relay window will appear as seen below.

In the main right section of the window you will see the following.
Name - This is where the name of this Relay, specified within the Peripheral
Wizard, is displayed.
Action - The Action dropdown is where you will choose what controls the Relay.
The Relay will only allow Actions as listed below.
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Subscription - Selects 'on/off' parameters to control the Relay.
Click on the FINISH button to implement the changes.
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Utilities - SC 32 / SC 64
The Utilities section of the SC 32 and SC 64 allows you to adjust, set and monitor
a number of items.
When the SC 32 and SC 64 are discovered by System Architect, they will
automatically detect certain items within the device that will be displayed in
Utilities.
To access Utilities simply click on the Tools Menu as seen below.
Click on the Utilities option.

The Utilities window will appear.
This window contains links on the left side of the page for the Front Panel,
Overall Status, Card Status, DSP Status and Time Settings as seen below.

Front Panel
Click on the Front Panel link. (opens as default)
The Front Panel section of Utilities allows you to change the contrast of the front
panel of the SC device.
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Overall Status
Click on the Overall Status link.
The Overall Status section allows you to see the current status of the following.
1) Audio Router
2) System Software
3) Ethernet
4) TCP/IP
5) All Systems

These will all show a pass (default when offline) or fail status.
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Card Status
Click on the Card Status link.
The Card Status section allows you to see the current status of the following.
1) Audio Card A
2) Audio Card B
3) Audio Card C
4) Audio Card D
These will all show a pass (default when offline) or fail status. The Card Status
section will only report status of cards that are loaded in online devices.
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DSP Status
Click on the DSP Status link.
The DSP Status section allows you to see the current status of the following.
1) Audio DSP A
2) Audio DSP B
3) Audio DSP C
4) Audio DSP D

These will all show a pass (default when offline) or fail status. The DSP Status
section will only report status of DSP per device selected. A through D for the SC
32 and A through H for the SC 64.

Time Settings
Click on the Time Settings link.
The Time Settings section allows you to see and change the following.
1) Current time and date. This is set through your computer by clicking on the
Insert PC Time button or manually with the up and down arrows next to the time
and date display.
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2) Timezone. Clicking on the Timezone allows you to choose the country or part
of the world that the install exists in.
3) Automatically adjust for Daylight Savings Time. Choosing this option will allow
the SC device to change the current time and date based on the location in the
world.
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Input Card Setup - SC 32 / SC 64
The Input Card Setup section of the Tools Menu for the SC 32 and SC 64 allows
you to adjust Analog Input Gain, Input High Pass frequency, Signal Generator
level and Sine Wave Generator Frequency.
When the SC 32 and SC 64 are discovered by System Architect, they will
automatically detect certain items within the device that will be displayed in Input
Card Setup. Only cards that are installed will be displayed in this section.
To access Input Card Setup simply click on the Tools Menu as seen below.

Click on the Input Card Setup option.

The Input Card Setup window will appear.
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This window contains a tab at the top of the page for each of the Analog Input
cards loaded into the device.

Input Channel Source Selection
Each channel contains a dropdown menu that selects the Analog Source or a
Signal Generator consisting of a SineWave, Pink Noise or White Noise
generator. Each selection will enable and disable the appropriate controls as
described below.
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Controls available when Analog Source is selected..
1) Analog Input Gain - this is the level of gain imposed on the input signal
2) High Pass Frequency - this is the lowest frequency that will pass forward to
other DSP object from the input forward.
3) Phantom Power - this determines whether the input will have 48V power
supplied or not.
You will be able to see the input level meter at all times and in all modes.
Controls available when Sine Wave is selected.
1) Signal Generator Level - this is the level of gain for the Sine Wave
2) Sine Wave Generator Frequency - this is the frequency of the sine wave
Controls available when Pink Noise or White Noise is selected.
1) Signal Generator Level - this is the level of gain for the Pink or White Noise
Generator
Complete the above as needed for each channel input as desired.
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Priority Mix Controls - SC 32 / SC 64
The Priority Mix Controls section of the Tools Menu for the SC 32 and SC 64
allows you to adjust the nine (9) levels of priority override ducking used in the
mixers of the SC 32 and SC 64.
To access Priority Mix Controls simply click on the Tools Menu as seen below.
Click on the Priority Mix Controls option.

The Priority Mix Controls window will appear.
This window contains the following controls for each priority override channel.
1) Depth - The gain reduction that will be imposed on all other channels with a
lower priority number. (Numbers range from 1 to 10 with 1 being the highest
priority)
2) Attack - The time it will take to override an existing source signal with the
priority source signal.
3) Hold - How long the priority override will stay in place once the priority source
signal is discontinued.
4) Release - The amount of time it will take to change back to the original source
signal from the priority source signal once the hold time has expired.
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The Priority Mix Controls are used to set a global priority setting to be used by all
mixers. Each Priority Level can have a different Depth, Attack, Hold and Release.
As Priorities are assigned within each channel of the Priority Mixer the
parameters set here will be applied.
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I/O Card Metering - SC 32 / SC 64
The I/O Card Metering section of the Tools Menu for the SC 32 and SC 64 allows
you to see the input and output levels for each card loaded into the SC 32 and
SC 64.
This is a prime location from which to drag meters to custom control panels.
To access I/O Card Metering simply click on the Tools Menu as seen below.
Click on the I/O Card Meters option.

The I/O Card Meters window will appear.
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Each tab of the I/O Card Meters window will show the 8 meters associated with
that Input or Output card.
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Help - SC 32 / SC 64
The Help file is the most complete way to find information on topics for control
and programming.
Click on the help menu option.

From this menu you may choose the following.
1) Contents - This will take you to the content tree with all topics as they relate to
the SC 32 and SC 64.
2) Index - This is a list of all topics within System Architect including those for the
SC 32 and SC 64.
3) Search - This brings you to a search page where you may type in what you
are looking for within help and find related topics.
4) Device Locate On - This will make the front panel LCD display flash on and off
for easy location of an online device within a rack of devices.
5) Device Locate Off - This turns off the locate LCD function.
6) About SC - This will give you information about the attached SC device.
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Device Presets - SC 32 / SC 64
A Device Preset is a snapshot of the current state of the SC 32 / SC 64. It
includes the parameter values of all of the Processing Modules in the current
configuration.
Recall - Opens the Recall Preset dialog where you can select a preset to load.
Store - After parameters are adjusted, click the Store button and the Store
Preset dialog will open allowing naming of the Device Preset as well as selection
of which memory location (1-50) it will occupy in the device.
Delete - Opens the Delete Preset dialog, where you can select and delete
Device Presets.
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Processing Modules SC 32 / SC 64
Processing Modules - SC 32 / SC 64
The SC 32 and SC64 are preconfigured architecture digital matrix processors.
They have input processing with two configurable insert positions, a central
matrix/mixer section and output processing with one configurable insert position.
The input and output processing contain multiple Processing Modules.
The input processing consists of a router, a delay, a 4-band parametric equalizer,
a gate and two insert positions.
The output processing consists of a router, an insert position, a band-pass filter,
a 6-band parametric equalizer, a limiter, a delay and a mute.

Double clicking on any Processing Module icon brings up the Editor for that
Processing Module.
e.g. Double clicking on the Gate Processing Module icon
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brings up the Gate editor

The table below shows the available insert Processing Modules for the input and
output insert positions.
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Input Editors - SC 32 / SC 64
Input Editors - SC 32 / SC 64
Processing in the SC 32 / SC 64 can broken into two distinct sections, Input and
Output. Input Processing includes everything in the signal path before Mid
Mixer/Router. As each processing function is represented by an icon, the Input
Processing functions are the group of icons on the left side of the control panel
and can include up to 48 different icons or modules. The Input Editors are shown
below.

Input Editors can be broken down into columns representing each type of
processing.
Input Router (RTE)
Input Delay (DLY)
Input 4-Band Parametric EQ (PEQ)
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Input Gate (GATE)
Input Inserts (INS1, INS2)
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Input Router - SC 32 / SC 64

Router - The Input Router allows you to adjust Source Gain for each channel
signal path.
Input Router editor:

To configure this section, select Tools > Wizards > Processing Wizard.
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Click on the Names and Routes link (under Inputs) to configure Routes and
Channel Labels.
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Input Delay - SC 32 / SC 64
The input delay section is used to time align or delay input signals as needed.
When the icon below is double clicked the window below will appear and allow
for quick access for input signal delay settings.

Delay - Processing circuit used to delay one or more of the output signals by a
controllable amount. This feature is used to correct for loudspeaker drivers that
are mounted such that their points of apparent sound origin (not necessarily their
voice coils) are not physically aligned.

On/Off Button - Each input has a delay On/Off button for the channel delay.
Delay Time Fader - This fader defines the delay time to be used either in
seconds, feet or meters.
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Input 4-Band Parametric EQ - SC 32 / SC 64

4-Band Parametric EQ - This 4-band Parametric Equalizer offers adjustment of
all the "parameters" of the filter; these parameters include Type, Frequency,
Gain, and "Q". This lets you control the amplitude of each band as well as shift
the center frequency and adjust the bandwidth of the filter.

On/Off Button - Turns the PEQ Processing Module on and off; when in the Off
position, the signal path bypasses this algorithm.
Flat Button - This flattens the PEQ.
Restore Button - This restores the PEQ after it has been flattened.
Filter Select 1-4 - This allows the user to select a filter to work with.
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Filter Enable Button - This button provides individual on/off control of each PEQ
filter.
Freq Fader - This fader allows the user to select the center frequency of a Bell
PEQ filter or the corner frequency of a Shelf filter.
Gain Fader - This provides control of the boost or cut of the selected filter.
Q Fader - This provides control of the Bell filter width or slope of a Shelf filter.
Type Selection - This allows any of the filters to be switched between Bell, Low
Shelf and High Shelf filter types.
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Input Gate - SC 32 / SC 64

Gate - A fixed "infinite" downward expansion ratio. Used extensively for
controlling unwanted noise, such as preventing "open" microphones from
introducing extraneous sounds into an audio system. When the incoming audio
signal drops below the user set-point (the threshold point) the expander prevents
any further output by reducing the gain to "zero".

On/Off Button - Turns the Gate on and off; when in the Off position, the signal
path bypasses this algorithm.
Threshold Fader - The Threshold fader sets the level at which the gate opens.
Anything above the Threshold passes, while signal that is lower than the
Threshold is attenuated. Beware, setting the Threshold to high can cut off the tail
end of signals as they fade out (the sustain of a guitar note, a held piano chord, a
reverb tail, etc.).
Ratio Fader - This is where you decide how much downward expansion you
want. This Ratio works opposite from that of the compressor or limiter. If a ratio
of 1:4 is selected, a signal that is 1dB below the Threshold will be reduced in gain
so that the resultant signal is 4dB below the Threshold.
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Max Atten. Fader - This fader sets the amount of maximum attenuation applied
to the signal once it has fallen below the Threshold.
Attack Fader - This fader sets the time it takes for the volume of the sound to go
from attenuated its original level.
Hold Fader - The Hold fader sets the amount of time the gate is held open after
the signal passes below the Threshold point.
Release Fader - The Release fader sets the speed at which the gate "closes" or
attenuates when the end of the Hold time is reached.
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Input DSP Inserts - SC 32 / SC 64
Input Inserts - SC 32 / SC 64
The following icons, when configured through the Processing Wizard, will appear
on the control panel. When you double click the Processing Module icon on the
Device Window, the editor for the DSP function will open.
Once the editor is open you may choose to change any of the parameters.
Advanced Feedback Suppression (AFS™)
Automatic Gain Control (AGC)
Compressor
De-Esser
12-Band Notch Filter
12-Band PEQ Filter
Sub-Harmonic Synthesizer

Inserts, Input DSP - To access this section, select Tools from the menu bar.
Then select Processing Wizard.

Click on the Inserts link (under Inputs).
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Auto Gain Control - SC 32 / SC 64

Automatic Gain Control - The AGC is used to keep the average level of a
signal at a constant level. High level signals are reduced by a fast limiter to
prevent distortion by clipping. The AGC Threshold meters show what region of
the AGC the input signal is in, T (yellow) within the Window, A + (red) Limiter, A (green) adding Gain

On/Off Button - The On/Off button turns the Auto Gain Control on and off; when
in the Off position, the signal path bypasses this algorithm.
Threshold Fader - This fader changes the level at which the AGC recognizes a
signal as a legitimate level to be increased into the AGC level Window. The
Threshold also defines the lower limit of the AGC. This prevents the AGC from
adding gain to low level signals or noise.
Gain Fader - This is the maximum amount of Gain to be applied to the signal
after it crosses the Threshold limit in an attempt to reach the Target.
Target Fader - This is the user defined optimum signal level to be achieved and
maintained.
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Window Fader - This fader adjusts the size of the Window around the target.
Decreasing the size of the Window maintains tighter control of the signal, while
opening the Window up provides less control.
Attack Fader - This fader sets the length of time after a signal crosses the
Threshold that gain or gain reduction will be applied.
Release Fader - This fader is the rate of change that will take effect after the
signal level has fallen below the Threshold and will no longer be controlled by
algorithm.
'Return To' Selection - This determines whether the AGC will return to an Idle
Gain setting or a Last Gain Setting.
Idle Gain Fader - This fader determines the Idle Gain setting for when the
'Return To' selection is set to Idle Gain.
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Advanced Feedback Suppression - SC 32 / SC 64

AFS - The SC 32 / SC 64 offers the dbx exclusive Advanced Feedback
Suppression (AFS™) algorithm as a Processing Module. This employs Precision
Frequency Detection to find the exact center of the feedback down to onehundredth of a Hertz (0.01Hz). Once the AFS algorithm knows the exact center,
it is relatively simple to place a sharp notch filter in that location, removing the
feedback without damaging the surrounding audio.

On/Off Button - Turns the AFS module on and off; when in the Off position, the
signal path bypasses this algorithm.
Clear Live - This parameter clears the live filters to their default state.
Clear All - This resets all feedback filters to their nominal (no cut) state.
Mode Selection - This determines whether the AFS algorithm is working in Fixed
mode or Live mode.
Fixed Mode - When the mode is set to Fixed, the algorithm updates only the
fixed filters. Fixed mode is designed to help setup the AFS algorithm and is more
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sensitive. In Fixed mode, once filters are set they remain stored as part of the
program until reset. Fixed mode is typically used before the performance without
any input signal.
Live Mode - When the mode is set to Live, the algorithm updates only the live
filters. In Live mode, the live filters automatically detect and remove feedback
during the performance. When all of the live filters have been used, they begin to
'round robin'. Essentially this means that the first live filter set will clear and be
reassigned to the new feedback frequency.
Type Selection - This allows the type of program material to be selected.
Options are Speech, Music Low, Music Medium and Music High.
Live Filter Lift - Live Filter Lift assigns a timer to each Live filter. Once the timer
for that filter has elapsed, the algorithm checks to see if that filter is still
necessary, if not the filter is lifted maintaining the sonic fidelity of the system. If
the filter is still needed the timer is reset and the algorithm will check again once
it has run out again.
Lift After Fader - This parameter allows the user to set the timer length for the
Live Filter Lift portion of the algorithm.
Detector - This parameter sets a high pass filter in the path of the AFS detector.
There may be occasions where the AFS algorithm is removing too much low end
because it is being triggered by synthesizer or bass notes that are not really
feedback. This parameter provides a mechanism to make the AFS algorithm less
sensitive to low frequency thereby setting fewer filters in the bass region.
Sensitivity Fader - The AFS algorithm is very effective when the audio has a
nominal level of 0 dBu, however if the audio is too low in level the AFS algorithm
may not catch feedback as quickly as possible. By increasing or decreasing the
sensitivity you can adjust for audio that is either too loud or too soft and help the
AFS function properly.
Fixed Filters Fader - This allows the user to select how many of the total
number of filters are Fixed and how many are Live. The Fixed/Live filter usage
will be indicated at the bottom of each page of the feedback elimination effect. 'F'
indicates an available fixed filter, and 'L' indicates an available live filter. A
blocked out F or L indicates a filter that is set, or in use.
Total Filters Fader - This fader determines the total number of filters to be used.
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Input Compressor - SC 32 / SC 64

Compressor - The Compressor Processing Module is used to reduce the
dynamic range of the signal passing through it. This is normally done through the
use of a VCA (Voltage Controlled Amplifier), whose gain is a function of a control
voltage applied to it.

On/Off Button - Turns the Compressor module on and off; when in the Off
position, the signal path bypasses this algorithm.
OverEasy Fader - OverEasy is a soft-knee smoothing function that occurs about
the compression threshold; the higher the OverEasy number the greater the
smoothing.
Threshold Fader - Threshold is the signal level at which the Compressor begins
gain reduction. If the Threshold is set to -10 dBu, then any signal that has a level
higher than -10 dBu is compressed while any signal that has a level lower than 10dBu is left at the original level. For most signals the most natural compression
is achieved when most of the signal content remains just below the threshold and
only the peaks cross the threshold.
Ratio Fader - Ratio is the amount the Compressor reduces the signal level of the
sound that is above the threshold. A 2:1 ratio means that if the incoming signal is
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2dB over the threshold the Compressor will reduce the gain with a resulting
signal that is 1dB over the threshold. For light compression, choose a lower ratio,
while heavy compression requires a higher ratio. A setting of Inf:1 makes the
Compressor act as a limiter.
Gain Fader - This parameter is used to compensate for the gain lost during
compression. By using heavy compression on a signal and then boosting the
signal with the ‘make-up’ Gain, the user can create a signal that sounds much
louder than it actually is.
Auto Button On/Off - When Auto mode is on, the algorithm dynamically sets the
Attack, Hold, and Release times for the Compressor. The Auto mode constantly
adjusts these parameters in real time for optimum performance from the
Compressor. You will find that for most applications, not only is using the Auto
mode faster and easier but by letting the Compressor constantly tweak these
parameters for you will result in a better end result.
Attack Fader - Attack is how fast the Compressor starts to compress the signal
after it passes the Threshold. Fast attack is useful when dealing with very fast
transients. The Attack fader is not active when in Auto mode.
Hold Fader - Hold is the time the compressor remains in compression mode
after the signal has dropped below the Threshold. A longer hold time is useful in
smoothing out the sound when compressing several fast peaks that are fairly
close together in time. The Hold fader is not active while in Auto mode.
Release Fader - Release is how fast the signal comes out of compression. The
Release is in dB per second. For example, if Release is set to 5 dB /sec, and the
signal is at 10dB of gain reduction, the release time is 2 seconds. Having a
release time that is either too fast or too slow for the signal can result in audible
artifacts called ‘pumping’ or ‘breathing’. This can cause volume drops in your
signal that may not be desired. The Release fader is not active while in Auto
mode.
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Input De-Esser - SC 32 / SC 64

De-Esser - The De-Esser Processing Module is ideal for removing unwanted
vocal sibilance.

On/Off Button - Turns the De-Esser on or off; when in the Off position the
algorithm is bypassed in the signal chain.
Type Selection - This allows selection between High Pass and Band Pass
detection filter types.
Frequency Fader - This is the center frequency the De-Esser uses when in
Band Pass mode or the corner frequency used when in High Pass mode.
Amount Fader - This fader determines the amount of De-Essing. This fader is
very much like a combination threshold / ratio control. A higher the number or
amount the greater the degree of De-Essing applied to the signal.
Width Fader - Sets the Q or width of the Band Pass filter when in Band Pass
mode.
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Input SubHarmonic Synthesizer - SC 32 / SC 64

Sub-Harmonic Synthesizer - The Sub-Harmonic Synthesizer Processing
Module has been specifically optimized to enhance Bass audio material.

On/Off Button - Turns the Sub-Harmonic Synthesizer Processing Module on
and off; when in the Off position, the signal path bypasses this algorithm.
Gain - This parameter sets the overall level of the Sub-Harmonic Synthesizer
added to the signal.
24-36 Hz and 36-56 Hz Level faders - These controls allow the user to
customize the amount of the respective synthesized frequencies to be added in,
tuning the ultimate bass response of your system to taste. Experimentation will
pay off with smooth, full, deeply extended bass. Remember, you are not
selecting a frequency. You are controlling the overall level of each band.
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Input 12-band Notch Filter - SC 32 / SC 64

12-Band Notch Filter - The 12-Band Notch Filter Processing Module is the
perfect tool for removing very specific undesirable frequencies that may appear
in the signal. With Q up to 128 and the ability to cut by up to 36 dB, the 12-Band
Notch Filter can provide extremely surgical frequency band removal.

On/Off button - Turns the 12-Band Notch Filter Processing Module on and off;
when in the Off position, the signal path bypasses this algorithm.
Filter Select (1 to 12) - Selects the desired Notch Filter.
Freq Fader - Sets the desired frequency of the selected Notch Filter.
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Gain Fader - Sets the level of the selected Notch Filter. Set to +6dB to help find
unwanted feedback, then set to -3dB to -36dB to remove.
Q Fader - Selects the Q or bandwidth of the selected Notch Filter.
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Input 12-Band PEQ - SC 32 / SC 64

12-Band PEQ Filter - This 12-band Parametric Equalization (PEQ) Filter offers
adjustment of all the "parameters" of the filter; these parameters include Type,
Frequency, Gain, and Q. This lets you control the amplitude of each band as well
as shift the center frequency and adjust the bandwidth of the filter.

On/Off Button - Turns the 12-Band PEQ Filter Processing Module on and off;
when in the Off position, the signal path bypasses this algorithm.
Flat Button - This flattens the PEQ.
Restore Button - This restores the PEQ after it has been flattened.
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Filter Select 1-12 - This allows the user to select a filter to work with.
Filter Enable Button - This button provides individual on/off control of each PEQ
filter.
Freq Fader - This fader allows the user to select the center frequency of a bell
PEQ filter or the corner frequency of a shelf filter.
Gain Fader - This provides control of the boost or cut of the selected filter.
Q Fader - This provides control of the bell filter width or slope of a shelf filter.
Type Selection - This allows selection between Bell, Low Shelf and High Shelf
filter types.
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Wire (input) - SC 32 / SC 64

“Wire” is the default setting within the Processing Wizard for input inserts. When
selected, audio passes through the insert unaffected.
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Output Editors - SC 32 / SC 64
Output Editors - SC 32 / SC 64
Processing in the SC 32 / SC 64 can be broken into two distinct sections, Input
and Output. Output Processing includes everything in the signal path after the
Input Delay. As each processing function is represented by an icon, the Output
Processing functions are the group of icons on the right hand side of the Control
Panel and can include up to 48 different icons or modules. The Output Editors
are shown below.

Input Editors can be broken down into columns representing each function.
Output Router (RTE)
Output Inserts (INS)
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Output Bandpass Filter Crossover (BPF)
Output EQ (PEQ)
Output Limiter (LIM)
Output Delay (DLY)
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Output Router - SC 32 / SC 64
The Output Router is the position where you will select whether you will select
between discrete signals or the output of a Mid Mixer.

Router - The Output Router allows you to specify which of the input or Mid Mixer
Output signals will be sent to the output or output group if crossed over.

To configure this section, select Tools > Wizards > Processing Wizard.
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Click on the Names and Routes link (under Outputs) to configure Routes,
Crossover types, and Output Channel Labels.
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Output DSP Inserts - SC 32 / SC 64
Output DSP Inserts - SC 32 / SC 64
The following icons when selected in the configuration wizard will appear on the
control panel. When you double click the icon on the control panel an edit
window for the DSP function will open and the parameters are available.

Wire

Ambient Noise Compensation (ANC)

AutoWarmth®

Automatic Gain Control

Gain

To configure this section, select Tools > Wizards > Processing Wizard.

Click on either the Input DSP Inserts and Delays link . . .
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. . . or select the Output DSP Inserts link.
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Wire (output) - SC 32 / SC 64

"Wire" is the default setting within the Processing Wizard for output inserts. When
selected, audio passes through the insert unaffected.
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Ambient Noise Compensation - SC 32 / SC 64

Ambient Noise Compensation (ANC) is a Processing Module that allows the level
of zone outputs to track the ambient noise level, monitored through a microphone
and microphone input. This feature is particularly well-suited to applications such
as retail environments where the volume of the audio system can be matched
automatically to the number of shoppers and their associated noise level.
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AutoWarmth - SC 32 / SC 64

AutoWarmth® is used to compensate for the natural loss in low frequency
sensitivity at lower volumes. Based on the Fletcher-Munson Equal Loudness
Curves this psychoacoustic algorithm provides automatic bass compensation
dependant on signal level. When the signal level is lowered, AutoWarmth
provides a non-linear expansion of bass frequencies match the natural loss on
low frequency response of the human ear.

On/Off button - Turns the AutoWarmth Processing Module On and Off; when in
the Off position, the signal path bypasses this algorithm.
Threshold fader - This fader changes the level at which the Auto-Warmth starts
to apply Automatic Bass Compensation. Once the signal drops below this
threshold level the algorithm begins boosting the bass frequencies.
Amount Fader - This is the ratio of Auto-Warmth to be applied to the sound. For
example, if set at 1:1 the Auto-Warmth follows the Fletcher Munsen Curves; if the
Ratio is higher than 1:1 then more bass will be boosted.
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Auto Gain Control - SC 32 / SC 64

Automatic Gain Control - The AGC is used to keep the average level of a
signal at a constant level. High level signals are reduced by a fast limiter to
prevent distortion by clipping. The AGC Threshold meters show what region of
the AGC the input signal is in, T (yellow) within the Window, A + (red) Limiter, A (green) adding Gain

On/Off Button - The On/Off button turns the Auto Gain Control on and off; when
in the Off position, the signal path bypasses this algorithm.
Threshold Fader - This fader changes the level at which the AGC recognizes a
signal as a legitimate level to be increased into the AGC level Window. The
Threshold also defines the lower limit of the AGC. This prevents the AGC from
adding gain to low level signals or noise.
Gain Fader - This is the maximum amount of Gain to be applied to the signal
after it crosses the Threshold limit in an attempt to reach the Target.
Target Fader - This is the user defined optimum signal level to be achieved and
maintained.
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Window Fader - This fader adjusts the size of the Window around the target.
Decreasing the size of the Window maintains tighter control of the signal, while
opening the Window up provides less control.
Attack Fader - This fader sets the length of time after a signal crosses the
Threshold that gain or gain reduction will be applied.
Release Fader - This fader is the rate of change that will take effect after the
signal level has fallen below the Threshold and will no longer be controlled by
algorithm.
'Return To' Selection - This determines whether the AGC will return to an Idle
Gain setting or a Last Gain Setting.
Idle Gain Fader - This fader determines the Idle Gain setting for when the
'Return To' selection is set to Idle Gain.
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Gain - SC 32 / SC 64

Gain is used to increase the output volume of a signal.

Fader - This fader increases or decreases the output volume.
Mute Button - This button mutes the signal when engaged, and un-mutes the
signal when disengaged.
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Output Bandpass Filter/Crossover - SC 32 / SC 64

Bandpass Filter (BPF) - The Bandpass Filter (BPF) is a collection of filters and
gain elements that can be used to frequency limit the outputs. By combining a
Highpass and Lowpass filter you can create a Bandpass filter that will only allow
the prescribed frequency bandwidth through the filter. By placing Bandpass filters
next to each other Crossovers are created that separate the high frequencies
from the low frequencies so that the speaker drivers operate within their optimal
range. Double clicking on the BPF icon will open the following editor, allowing the
user quick access to the Bandpass Filter parameters.

Band Select 1 to (up to) 4 - The Band Select is the location where you chose
the specific ‘band’ or output you want to affect.
Hi Pass Fader - This fader sets the low frequency limit for this output band. It
allows the high frequencies resulting in the name High-Pass or Highpass.
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Lo Pass Fader - This fader sets the high frequency limit for this output band.
This filter allows the low frequency through resulting in the name Low-Pass or
Lowpass.
Gain Fader - This fader sets the output level for the selected band.
Phase Fader - The Phase fader allows the user to add additional non-linear
delay by implementing an all-pass filter. This filter can delay the output by
between 0 degrees and -179 degrees of Phase at the Lowpass filter frequency.
This phase change is relative to the output polarity of the band. The ability of
changing phase is most useful at low frequencies when neither in polarity (+) or
out of polarity (-) seem to provide the optimal response.
Slope - The slope allows the user to select between different filter types and
slopes to achieve the desired result. The user may choose between Butterworth
(BW 6, 12, 18 and 24), Bessel (BS 6, 12, 18 and 24) and Linkwitz-Riley (LR 12
and 24) filter types.
Mute Button – This button mutes the selected band when engaged, and unmutes the band when disengaged.
Polarity (+ / -) Button - This button sets whether the output signal will have a
positive or negative output polarity. Said differently, changing from positive to
negative will result in a positive voltage on the input of the SC 32 / SC 64 to
result in a backward movement of the speaker cone.
To configure this section, select Tools > Wizards > Processing Wizard.

Click on the Names and Routes link (under Outputs), then select from the
Crossovers pull-down menus.
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You may select from the following list the type of crossover filtering that best suits
your needs.
•
•
•
•

1x1 mono
1x2 (mono bi-amp)
1x3 (mono tri-amp)
1x4 (mono quad)
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Output 6-Band PEQ - SC 32 / SC 64

6-Band Parametric EQ - This 6-band Parametric Equalizer offers adjustment of
all the "parameters" of the filter; these parameters include Type, Frequency,
Gain, and "Q". This lets you control the amplitude of each band as well as shift
the center frequency and adjust the bandwidth of the filter.

On/Off Button - Turns the 6-Band PEQ Filter Processing Module on and off;
when in the Off position, the signal path bypasses this algorithm.
Flat Button - This flattens the PEQ.
Restore Button - This restores the PEQ after it has been flattened.
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Filter Select 1-6 - This allows the user to select a filter to work with.
Filter Enable Button - This button provides individual on/off control of each PEQ
filter.
Freq Fader - This fader allows the user to select the center frequency of a bell
PEQ filter or the corner frequency of a shelf filter.
Gain Fader - This provides control of the boost or cut of the selected filter.
Q Fader - This provides control of the bell filter width or slope of a shelf filter.
Type Selection - This allows selection between Bell, Low Shelf and High Shelf
filter types.
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Output Limiter - SC 32 / SC 64

Limiter - Signal processor used to Limit the dynamic range of the signal passing
through it. This is normally done through the use of a VCA (Voltage Controlled
Amplifier), whose gain is a function of a control voltage applied to it.

/

On/Off Button - Turns the Limiter Processing Module on and off; when in the Off
position, the signal path bypasses this algorithm.
OverEasy Fader - OverEasy is a soft-knee smoothing that occurs in the
transition about the Limiter threshold. The higher the OverEasy number, the
greater the smoothing.
Threshold Fader - The threshold is the signal level at which the Limiter starts to
reduce the gain. If the Threshold is set to -10 dBFS, then any signal larger than 10 dBFS will be limited while any signal lower than -10dBFS is left at the original
level. Limiting is used differently from compression, in that it typically is used to
provide system protection. No signal level above the threshold will be passed
without regard to increase above the threshold.
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PeakStopPlus® On/Off - The first stage of PeakStopPlus is the Instantaneous
Transient Clamp™ which clamps the signal with a soft logarithmic clamp
function. This logarithmic function ensures that the signal will not exceed the
level set by the PeakStopPlus Overshoot control by more than the Overshoot
amount, and that it will not introduce harsh artifacts. The second stage is a
unique program limiter featuring Intelligent Predictive Limiting™. Its function is to
monitor the input signal and intelligently predict the amount of gain reduction
needed to keep the output signal below the ceiling set by the Instantaneous
Transient Clamp™.
Overshoot 2 dB - 6 dB - This parameter sets the amount of overshoot for the
Instantaneous Transient Clamp™.
Auto Button On/Off - When Auto mode is on, this insert dynamically sets the
Attack, Hold, and Release times for the signal. The Auto mode constantly adjusts
these parameters in real time for optimum performance from the Limiter. You will
find that for most applications, not only is using the Auto mode faster and easier
but by letting the Limiter constantly tweak these parameters, the outcome will
sound better.
Attack Fader - Attack is how fast the Limiter starts to reduce the gain after the
signal crosses the Threshold. Fast Attack is useful when dealing with very fast
transients. The Attack control is not active when in Auto mode.
Hold Fader - Hold is the amount of time the limiter remains in gain reduction
after the signal has dropped below the threshold. A longer hold time is useful in
smoothing out the sound when limiting several fast peaks that are fairly close
together in time. The hold control is not active while in auto mode.
Release Fader - Release is how fast the signal comes out of compression. The
release is in dB per second. For example, if release is set to 5 dB /sec, and the
signal is at 10dB of gain reduction, the Release time is 2 seconds. Having a
Release time that is either too fast or too slow for the signal can result in audible
artifacts called 'pumping' or 'breathing'. This can cause volume drops in your
signal that may not be desired. The Release control is not active while in Auto
mode.
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Output Delay - SC 32 / SC 64

Delay - Processing circuit used to delay one or more of the output signals by a
controllable amount. This feature is used to correct for loudspeaker drivers that
are mounted such that their points of apparent sound origin (not necessarily their
voice coils) are not physically aligned.

On/Off Button - Each input has a delay On/Off button for the channel delay.
Delay Time Fader - This fader defines the delay time to be used either in
seconds, feet or meters.
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Creating Panel Presets - SC 32 / SC 64
A Panel Preset is a preset that recalls the state of one or more parameters on a
single custom control panel. It is a snapshot of the values that are set on the
panel.
A Panel Preset can manage multiple parameters from multiple devices.
Panel Presets are saved, recalled, and deleted with the Panel Preset Bar.
They are identified with a panel number and name.
A Panel Preset saves the current values and control parameters on a custom
control panel; when additional parameters are added or values are changed, the
panel preset must be saved again to include them.
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Scheduling - SC 32 / SC 64
The scheduler allows different types of events to be scheduled for specific times.
These events recall information or perform a function either in the System
Architect software or on the SC devices themselves. The events that can be
scheduled include device presets, venue recalls and panel presets.
See Scheduler in System Architect Help.
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Wiring
Wiring - SC 32 / SC 64
Audio Cable Wiring
All audio and control connections to the SC 64/ SC 32 are via 12 terminal female
Phoenix Combicon-style 3.5mm connectors, which are supplied for making these
connections.

Audio Input and Output Wiring Convention
Balanced wiring - The convention for balanced wiring (2-wire plus shield) is:

Unbalanced wiring - The convention for unbalanced wiring to the inputs (1-wire
plus shield) is:
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Control Inputs
Used to connect contact closures. There are two common (ground) connections,
labeled "C" to the left of the eight CONTROL INPUTS, and two reference voltage
outputs, labeled "R" to the right of the eight CONTROL INPUTS.

Relay Contacts
Supports control of a voltage source and load that is AC, or supports control of a
voltage source and load that is higher-current DC than is supported by the logic
outputs. A normally open circuit or a normally closed circuit is available.

OPTO Output
In addition to the six standard logic outputs, there is an isolated output, which
fails safe (open circuit) if the unit becomes faulty.

Logic Outputs
Used to connect 'tally' indicator LEDs or relays. There are six standard LOGIC
OUTPUTS which produce 0V or +5V DC via an internal 440 Ohm resistor and
one internally connected common (ground) connection C.
An LED connected between one output (Anode, A) and common (Cathode,
K) will illuminate when the logic output is activated, without requiring any
external current limiting resistor. A high sensitivity relay (such as a reed
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relay) may be driven by connecting four outputs in parallel. This
arrangement will develop 4V across a 500-Ohm coil, providing that all four
outputs are made logic 1 simultaneously.
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Ethernet - SC 32 / SC 64
Zone Controller Cat5 Cable
The Zone Controllers may use standard Cat5 Cable. The pin configuration is
shown below. The link buss cable uses the same straight through cable
configuration as the Zone Controllers.
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Zone Controllers - SC 32 / SC 64
Zone Controller Installation
The installation of the Zone Controllers MUST be accomplished with the use of
cable which is rated VW-1 or higher. Common NEC designations which meet this
rating include: CMP, CMR, CMG, CM and CMX.
ZC-1 - The ZC-1 is a programmable zone controller that allows input or output
volume level control from a wall panel.
ZC-2 - The ZC-2 is a programmable zone controller that allows input or output
volume level and mute control from a wall panel.
ZC-3 - The ZC-3 allows wall panel routing and Actions selection for the SC
devices.
ZC-4 - The ZC-4 provides contact closure routing and Actions selection for room
combining or fire safety applications.
ZC-Fire - The ZC-Fire is the interface to generic fire alarm relays. When fire
alarm activates, the general purpose relay can typically be programmed to close
if normally open or vices-versa. The ZC-fire interface unit monitors the state of
the relay (n.o. or n.c.) and upon the state of change, notifies the SC 32/64, which
then mutes its outputs.
ZC-6 - The ZC-6 is a push-button up and down input or output volume controller.
ZC-7 - The ZC-7 allows Actions selection for the SC devices.
ZC-8 - The ZC-8 is used for a combination of input or output volume up/down,
and four position source/program select.
ZC-9 - The ZC-9 allows wall panel routing and Actions selection for the SC
devices.
ZC-BOB - The ZC-BOB allows parallel or home run cabling of the Zone
Controllers.
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RS-232 - SC 32 / SC 64
The serial (RS-232) connection to the SC 32 / SC 64 is made through a Null
Modem cable. A straight-through serial (RS-232) cable will not work.

Network connections made directly from the SC 32 / SC 64 must be made using
a crossover cable.
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Zone Controller Distance Limitations - SC 32 / SC 64
All Zone Controllers can be wired serially or in parallel. As length increases, the
total cable distance decreases. One controller can be wired with up to 1000 feet
of cable, three controllers in series at 600 feet and six controllers in series at 300
feet total cable length.

If longer cable lengths are required then the use of a ZC-BOB is available. The
ZC-BOB allows you to add up to 1000 feet of cable to be run directly to a Zone
Controller from each of the 6 BOB ports. (See picture below)
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.
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Zone Controller DIP Switch - SC 32 / SC 64
Zone Controller Wiring
All Zone Controllers can be wired serially or in parallel. To wire in series, each
Zone Controller must have an identification number (ID) chosen using the DIP
switches on the side of the controller (see diagram A). A single Zone Controller
can be used to control multiple outputs. Conversely, multiple Zone Controllers
can be used to control a single zone – e.g. A ZC1 and a ZC3 controlling volume
and source in a single zone respectively. In every case, each Zone Controller is
given a unique ID. The Zone Controllers can then be wired together and
connected to the SC devices (see diagram B).
To wire the Zone Controllers in parallel, a ZC-BOB must be used. Each
Zone Controller must have a unique identification or number chosen using
the DIP switches on the side of the controller (see diagram A). To wire in
parallel, each controller must be wired into a port of the ZC-BOB with a
connecting wire going to the SC device (see diagram C).
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SC32/SC64 Help
To set up the ZCs, the System Architect GUI must be used. Open the GUI and
click on ZC Wizard in the Tools menu. Select the type of ZC and the ID#. The ID
numbers on the left side of the window correspond to the identification number
set using the DIP switches on the individual zone controllers. To select ID#2 for
example, simply flip the 2 switch into the on position. ID 1-6 are connected to top
ZC input on the rear panel and ID 7-12 are connected to the bottom input. To
create ID 7-12, add 6 to the ID # selected on the back of the ZC. For example, to
get an ID# of 10, connect to the bottom ZC Input (7-12) and set the ID# to 4.
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